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Introduction

Welcome to this First Steps guide, which we have created to help you get started with Dorico by 
taking you through all the steps necessary to create and prepare a short piano piece followed by 
an extract of a blues song.

We hope that the principles and techniques you learn as part of this guide help you become 
familiar with common operations and feel more confident when working on your own projects.

This guide introduces you to the following:

● The user interface and its most important parts

● The different modes in Dorico and their functions

● Setting up a project

● Writing music and adding the notations required to produce a short piano piece and some 
additional common notations in a separate piece

● Laying out and formatting pages, including adjusting notations such as beam grouping and 
stem directions

● Playing back music and adjusting playback

● Printing and exporting

The piano piece used in these tasks is Dora Pejačević’s “Walzer-Capricen No. 2”. A PDF of the full 
piece is available on steinberg.help for your reference.

Within a relatively short duration, this piece contains many notations common to most musical 
styles, such as dynamics and articulations, as well as notes in multiple voices simultaneously, 
chords, and cross-staff beaming. Other common notations not included in this piece, such as 
lyrics and chord symbols, are in a separate section at the end of the guide.

NOTE

● Screenshots in this guide show Dorico Pro. Tasks are possible in all product versions unless 
stated otherwise.

● For further information about anything mentioned in this guide, see the Operation Manual.

Tour of the user interface
In Dorico, the user interface is everything within the project window. Its basic structure is the 
same in all modes.

The project window looks like this and consists of the following areas:
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1 Toolbar

The toolbar is located at the top of the project window.

On the left of the toolbar, there are the buttons for the different modes. By changing the 
mode, you change the workspace and the available panels. The button for the current mode 
appears highlighted. You can find out more about modes in the next topic.

NOTE

Dorico Elements and Dorico SE do not have an Engrave button as they do not have Engrave 
mode.

In the middle of the toolbar, there is the layout selector, which allows you to change the 
layout shown in the music area, and buttons to show/hide panels and tabs.

On the right of the toolbar, there are buttons for hiding/showing the Video, Mixer, and 
Transport windows and a mini transport with playback and recording controls.

2 Tab bar

The tab bar is located towards the top of the project window, between the toolbar and the 
music area. It is available in Setup, Write, and Engrave modes.

The tab bar shows the tabs that are currently open, the name of the layout open in each 
tab, and allows you to open more tabs. If you split the music area and open several tabs, tab 
groups are shown.

3 Project start area/Music area/Event display/Print preview area

The central part of the project window where you work on your project. When you set up 
a new empty project, this area in Setup, Write, and Engrave modes shows the project start 
area that allows you to add your first players.

Once you have added a player or an ensemble, this area becomes the music area that 
displays the scores and instrumental parts that you create.

Introduction
Tour of the user interface 
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In Play mode, this area contains an event display, in which every note is displayed as an 
event on a piano roll or drum editor, and shows the effects of manipulating the playback of 
your music.

In Print mode, this area becomes the print preview area, which shows a preview of how 
layouts will appear when printed onto paper or exported into a graphics file format.

TIP

Scores and instrumental parts are known as “layouts” in Dorico. Layouts allow you to show 
different presentations of your music. In a project with separate instrumental parts, such as 
a string quartet, you can switch between showing the full score layout and each part layout 
in the current tab. You can have as many or as few tabs open as you want.

4 Toolboxes

Toolboxes are the columns on the left and right edges of the project window. They contain 
different tools and options according to the current mode. Toolboxes allow you to input and 
modify notes, notation items, and frames, and to determine which options are shown in their 
corresponding panels.

You cannot hide toolboxes, they are always shown.

5 Panels

Panels are areas on the left, right, and bottom edges of the project window. They contain 
a variety of functions, options, and notations that you need to create and edit your music, 
depending on the mode. For example, the left panel in Write mode is the Notes panel, which 
contains durations for notes, common accidentals, slurs, and articulations.

You can hide and show panels either individually or together. To hide/show all panels, click 
Hide/Restore Panels  in the toolbar. To hide/show individual panels, press Ctrl/Cmd-7  for 
the left panel, Ctrl/Cmd-8  for the bottom panel, and Ctrl/Cmd-9  for the right panel.

6 Status bar

The status bar is the strip at the bottom of the project window. It allows you to change 
the rhythmic grid resolution , choose different views and page arrangements for the 
music area, change the zoom, and displays information about your current selection, such as 
the bar number in which you have selected a note. It contains different options in different 
modes.

Functions of the modes
In Dorico, there are different modes: Setup, Write, Engrave, Play, and Print. Each mode 
represents a different phase in the workflow of preparing scores and parts, so they contain 
different toolboxes, panels, and functionality from each other.

Setup mode
In Setup mode, you can set up the fundamental elements of the project: instruments 
and the players that hold them, flows, layouts, and videos. You can also determine how 
they interact with each other, for example, by changing the players assigned to layouts.

You can view music in the music area and switch between viewing other tabs and 
layouts, but you cannot select or interact with anything in the music area in Setup 
mode.

Write mode
In Write mode, you can input and edit your music, including changing the rhythmic 
positions of items, changing the pitch of notes, and deleting notes and items. The 
available toolboxes and panels allow you to input all the notes and notation items that 
are most commonly used.

Introduction
Functions of the modes 
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By design, you cannot move notes and items graphically on the page in Write mode. 
Graphical adjustments are only possible in Engrave mode.

Engrave mode (Dorico Pro only)
In Engrave mode, you can make fine adjustments to the music that you input in Write 
mode and determine how the pages of your project are laid out.

Because Engrave mode is focused on the formatting and appearance of layouts, you 
cannot delete any notes or items, change their rhythmic positions, or change the pitch 
of notes in Engrave mode.

Play mode
In Play mode, you can change how your music sounds in playback. You can do this by 
changing the playback template and assigning VST instruments, inputting automation, 
adjusting the mix, and changing the sounding duration of notes in playback without 
affecting their notated duration.

Print mode
In Print mode, you can print your layouts or export them as graphics files. When 
printing layouts, you can specify the paper size and other options, such as duplex or 
booklet printing. When exporting layouts, you can specify different graphics file types, 
such as PDF or PNG, and the information you want to include in their exported file 
names.

You can switch between the modes at any time in any of the following ways:

● Press Ctrl/Cmd  plus one of the numbers 1  to 5  ( Ctrl/Cmd-1  for Setup, Ctrl/Cmd-2  for 
Write, Ctrl/Cmd-3  for Engrave, Ctrl/Cmd-4  for Play, Ctrl/Cmd-5  for Print).

● Click the corresponding button in the toolbar.

● Choose Window > [mode].

Dorico projects
A project is an individual file that contains all required musical information, including multiple 
instruments, their music, and playback settings.

In Dorico, separate spans of music are known as “flows”. A flow could be a single song in an 
album, a movement in a sonata or symphony, a number in a stage musical, or a short scale or 
sight-reading exercise of only a few bars in length. A single project can contain any number of 
flows and each flow can use any combination of players. For example, if brass players are tacet in 
one movement, you can remove them from that flow but keep them in other flows.

Players represent musicians who hold instruments. A solo player represents a single person who 
can play one or more instruments, such as a clarinettist who doubles on alto saxophone or a 
percussionist with various percussion instruments. A section player represents multiple people 
who all play the same instrument, such as a violin section in an orchestra or a soprano section 
in a choir. Section players can only hold a single instrument, but they can be divided into smaller 
units and onto multiple staves in Dorico Pro.

Layouts combine the musical content of flows and players with page formatting to produce 
paginated music notation. You can have any number of layouts in a single project with any 
combination of players and flows. For example, you can include a rehearsal piano player in the 
vocal score layout without showing them in the full score. Different layouts can have different 
page sizes and margins, for example, but also different appearances of notations. Full score and 
part layouts have different default settings.

Introduction
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Key commands
Key commands are sets of keys that perform defined tasks when pressed together. They are 
also known as “keyboard shortcuts” or “hotkeys”. Many key commands are the same on different 
operating systems but some are not, and this guide distinguishes them.

When key commands use equivalent modifier keys depending on the operating system, the 
modifier keys are indicated separated by a slash, with the Windows modifier key first and the 
macOS modifier key second.

EXAMPLE
Ctrl/Cmd-Alt/Opt-Down Arrow  means: press Ctrl - Alt - Down Arrow  on Windows, Cmd - Opt -
Down Arrow  on macOS.

When key commands require entirely different keys depending on the operating system, they are 
indicated with the Windows key command first, followed by the macOS key command.

EXAMPLE
Ctrl (Windows) or Opt (macOS)  means: press Ctrl  on Windows, Opt  on macOS.

Dorico provides multiple ways of inputting many items in order to cater for users who prefer 
to use the mouse for input as well as those who prefer only to use their computer keyboard. 
This guide focuses on using the keyboard in order to provide a simpler sequence of steps for 
you to follow, and because Dorico’s key commands have been designed to be both logical and 
accessible using a standard computer keyboard without needing a number pad. However, this 
guide also includes references to the mouse input methods along the way.

EXAMPLE
The arrow keys on their own navigate the selection around the music area. Adding Alt/Opt 
to the arrow keys moves notes and items rhythmically in Write mode and a small amount 
graphically in Engrave mode. For example, Alt/Opt-Up Arrow / Alt/Opt-Down Arrow  transpose 
notes up/down by staff position. Adding Ctrl/Cmd  as well moves notes and items by a larger 
amount. For example, Ctrl/Cmd-Alt/Opt-Up Arrow / Ctrl/Cmd-Alt/Opt-Down Arrow  transpose 
notes up/down by octave.

Introduction
Key commands 
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Setting up the project

To walk you through setting up the project for this solo piano piece, the following tasks cover 
starting a new project, adding a piano to it, and deleting the spare part layout.

Starting a new project
The first step in producing a piece in Dorico is to start a new project. These steps describe 
starting an empty project so you can learn how to add individual instruments and players 
yourself.

PREREQUISITE
You have installed and opened Dorico.

PROCEDURE

● Press Ctrl/Cmd-N  to start a new project.

● You can also choose File > New.

RESULT
A new project window opens.

New empty projects start in Setup mode. This allows you to add players and instruments straight 
away. Once you have added at least one player, the project start area in the middle becomes the 
music area and shows staves.

On the left, the Players panel is where all the players in the project are listed. It’s currently 
empty, as you haven’t added any players yet.
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On the right, the Layouts panel shows a Full score layout card. This layout is automatically 
created in every new project.

At the bottom of the window is the Flows panel. All the flows in your project are shown here.

TIP

Dorico provides project templates with different sets of players already included, such as a string 
quartet or SSAATTBB choir.

Adding a solo piano player
The piece you are replicating is for solo piano, so you need to add a single solo player and assign 
a piano instrument to them.

PROCEDURE

1. Press Shift-P  to add a new solo player and open the instrument picker.

● You can also click Add Solo Player  in the project start area.

2. Enter piano into the instrument picker search box.

3. Click Add or press Return .

RESULT
You have added a solo player and assigned a piano instrument to them. In the music area, the 
required piano staves and their respective clefs appear.

In the Layouts panel on the right of the window, there is now a piano part layout in addition to 
the existing full score layout. Dorico automatically creates a part layout for every player you add 
to the project.

Setting up the project
Adding a solo piano player 
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Deleting the spare layout
As this piece only involves one player, you can delete the part layout created by default and just 
keep the full score. In projects that contain a single player, you might find that having only one 
layout makes it easier to keep track of your work.

PROCEDURE

1. In the Layouts panel on the right, select the Piano layout.

2. Press Backspace or Delete .

● You can also click Delete Layout  in the action bar at the bottom of the panel.

RESULT
The piano part layout is deleted, leaving only the full score layout.

AFTER COMPLETING THIS TASK
We recommend saving your project.

Setting up the project
Deleting the spare layout 

11
Dorico 3.5.12



Writing music

Now that you have set up your project, you can start writing the music. The following tasks take 
you through inputting the notes and notation items required for this piano piece, with a separate 
task for each item for clarity, although Dorico is designed so that you can also input most items 
at the same time as inputting notes and other notations: you don’t have to stop note input to add 
a dynamic, for example.

Other common notations not included in this piece, such as lyrics and chord symbols, are in a 
separate section at the end of the guide.

Some steps involve performing actions in specific bars. The bar number of the currently selected 
item is shown in the status bar at the bottom of the window. The system track (the translucent 
gray line above the system) also displays every bar number; you can hide/show the system track 
by pressing Alt/Opt-T . Alternatively, you can show bar numbers for every bar in the music by 
pressing Ctrl/Cmd-Shift-L  to open Layout Options, clicking Bar Numbers in the category list 
on the left of the dialog, then choosing Every bar for Show bar numbers in the Frequency 
subsection.

Popovers
During the following tasks, you will be using popovers to input notations such as key signatures 
and dynamics. Popovers are temporary value fields that appear above the staff and allow you to 
input different items and perform tasks using text entries.

There are specific popovers for different purposes, such as inputting key signatures or adding 
notes specific intervals above existing notes. You can only use popovers in Write mode.

The dynamics popover with an example entry

One of the key benefits of popovers is that you can use them as you input notes: once you 
reach the position where you want to input a new time signature, for example, you can open the 
time signatures popover using its key command, input the time signature you want, and then 
continue inputting notes.

Although specific entries are required for many notations, the correct entries for different 
notations are consistently and logically structured. For example, tuplets are always expressed 
as a ratio, such as 3:2 or 5:4. Key signatures are expressed using upper case letters for major 
keys and lower case letters for minor keys. Time signatures are expressed as a pair of separated 
numbers; common time signatures use a slash, such as 3/4 or 6/8.

You can identify popovers by the icon on their left-hand side, which are the same icons used in 
the Notations toolbox on the right of the window. The Notations toolbox allows you to hide/show 
the corresponding notation’s panel, which is another way you can input notations if you prefer to 
use the mouse.
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Adding a key signature
All new projects in Dorico start with no key signature, which is treated as atonal, that is, without 
an implied tonality. This piece is in A♭ major, so you need to input a key signature.

PREREQUISITE

● You must be in Write mode. If you are, Write in the toolbar appears highlighted. If you are 
not, press Ctrl/Cmd-2  or click Write in the toolbar to switch to Write mode.

● If you want to zoom in, you can do so by, for example, pressing Ctrl/Cmd-= or Z  or using the 
zoom options  in the status bar at the bottom of the project window.

PROCEDURE

1. Click the rest on the top staff.

2. Press Shift-K  to open the key signatures popover.

3. Enter Ab into the popover.

● Upper case letters indicate major key signatures, lower case letters indicate minor key 
signatures. You can also enter b for flat and # for sharp.

4. Press Return  to close the popover.

RESULT
An A♭ major key signature is input at the start of the rest, which is the start of the flow. It is 
automatically positioned to the right of the initial clefs.

Writing music
Adding a key signature 
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TIP

You can also add key signatures using the Key Signatures, Tonality Systems, and Accidentals 
panel on the right of the window, which you can show by clicking Key Signatures, Tonality 
Systems, and Accidentals  in the Notations toolbox. Instead of opening the popover, you can 
click the down arrow  in the Key Signatures section until the display has four flats, make sure 
Major is selected, and then click the key signature to input it.

Adding a time signature
All new Dorico projects start with no time signature by default. As this piece is in 3/4, it requires a 
time signature.

You can input notes without a time signature, but you can only add extra bars once you have 
input a time signature so Dorico knows how long the bars should be. You can change and 
delete time signatures at any time: Dorico moves barlines and adjusts how notes are notated 
accordingly.

PROCEDURE

1. Click the rest on the top staff.

2. Press Shift-M  to open the time signatures popover.

3. Enter 3/4 into the popover.

4. Press Return  to close the popover.

RESULT
A 3/4 time signature is input at the rhythmic position of the selected rest, which is the start of the 
flow. It is automatically shown to the right of both the initial clefs and key signature. There is now 
a single bar’s worth of rhythmic space in the flow.

TIP

You can also add time signatures using the Time Signatures (Meter) panel on the right of the 
window, which you can show by clicking Time Signatures (Meter)  in the Notations toolbox.

Writing music
Adding a time signature 
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Adding bars
Dorico automatically creates bars when you reach the end of the last bar as you input notes. 
However, it can be helpful to have all the bars you will need in advance.

PREREQUISITE
You must have input the time signature so Dorico knows how long the bars should be.

PROCEDURE

1. Select the rest on the top staff.

● You can select items by clicking them or by using the keyboard. If nothing is selected in 
the music area, pressing any of the arrow keys selects the first note/rest on the top staff. 
Right Arrow / Left Arrow  move the selection along notes on one staff, Up Arrow /
Down Arrow  move the selection up/down notes in chords and to staves above/below. 
Tab  switches the selection to other types of items at the same position, such as from a 
note to a dynamic or slur.

2. Press Shift-B  to open the bars and barlines popover.

3. Enter 73 into the popover.

4. Press Return  to close the popover.

RESULT
73 bars are added, bringing the total number of bars in the flow to 74, the number required 
for this piece. They are currently spaced narrowly because they are empty, but Dorico will 
automatically adjust their width as you input notes.

AFTER COMPLETING THIS TASK
Using the key signatures popover ( Shift-K ), input a key signature change to D♭ major in bar 33, 
and another back to A♭ major in bar 43 using the popover entries Db and Ab respectively. Dorico 
automatically shows double barlines at the key signature changes.

Writing music
Adding bars 
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Caret
During the following tasks, you will be using the caret to input notes. In Dorico, the caret is a 
vertical line that shows the rhythmic position at which notes, chords, or notation items are input.

The caret has a note symbol beside it, which indicates the stem direction and type of the 
currently selected voice. It has a + symbol if the voice is new.

The appearance and behavior of the caret changes depending on the input mode and the 
currently selected voice number. For example, when you are inputting notes, the caret advances 
to the next rhythmic position automatically after each note, but when inputting chords or notes 
on tablature, the caret does not advance automatically. The caret also looks different when 
inputting grace notes or notes into a slash voice, and when Insert or Chord mode is activated.

Inputting the melody on the top staff
In this piece, the melody is on the top, treble staff. For the first few bars of the melody, you need 
to input individual notes in sequence.

PROCEDURE

1. In bar 1, select the rest on the top staff.

2. Press Shift-N  to start note input.

● You can tell you are in note input when the caret is activated and appears on the staff. 
Lines indicating the rhythmic grid also appear above the staff when the caret is active.

In the Notes panel on the left of the window, the quarter note button is highlighted. This 
indicates the note duration that will be used for the next notes you input. Quarter note 
(crotchet) is the default note duration when you start note input.

● However, the first four notes in the melody in this piece are eighth notes.

3. Press 5  to select eighth notes (quavers).

● The key commands for note durations use the numbers at the top of your computer 
keyboard, although you can also use a number pad. 6  is quarter notes (crotchets), 

Writing music
Caret 
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with smaller numbers used for smaller durations and larger numbers used for larger 
durations.

● The caret is still at the beginning of the bar, but the first note in the melody is on the 
second beat. However, you don’t need to input rests to get there.

4. Press Space  twice to advance the caret two eighth notes.

● During note input, Space  advances the caret by the note duration currently selected in 
the Notes panel.

5. Press F , then G , then A , then B  to input the corresponding pitches.

● The four notes are input as eighth notes starting from the caret position. Dorico 
automatically beams the notes and shows a quarter note rest at the start of the bar.

● Dorico uses the letters A-G on your computer keyboard for note pitches. Notes with 
accidentals in the key signature automatically follow the key signature unless you specify 
otherwise. So when you press A  and B , an A♭ and B♭ are input.

● The next note is a dotted half note, not an eighth note.

6. Press 7  to select half notes (minims), then .  (period) to add a rhythm dot, making the 
duration dotted half notes.

NOTE

You must press .  on your computer keyboard, not a numeric keypad.

7. Press G  to input a dotted half note G.

● Dorico automatically selects notes the smallest interval away from the previous note, so 
here the G is input a third below, rather than a sixth above, the preceding B.

8. Repeat steps 3 to 7 for bars 3-4.

Writing music
Inputting the melody on the top staff 
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TIP

Alternatively, you can press Esc  to stop note input, select bars 1-2 on the top staff (including 
the quarter note rest), then press R  to repeat the material directly after itself.

9. Press Esc  or Return  to stop note input.

RESULT
You have input all the notes required in the first four bars for the top staff.

TIP

You can also input notes by clicking on staves when the caret is active and Select  in the Notes 
toolbox is deactivated, or by playing them on a connected MIDI keyboard.

AFTER COMPLETING THIS TASK
Continue inputting notes on the top staff using what you have learned in this task up until the 
end of bar eight. To input the low F at the start of bar 7 after the high F at the end of bar 6, press 
Ctrl-Alt-F (Windows) or Ctrl-F (macOS) . If you input a higher F instead, press Ctrl/Cmd-Alt/
Opt-Down Arrow  to transpose it down an octave.

Changing the beam grouping will be covered in a later task.

Inputting the chords on the bottom staff
Inputting notes on top of each other to create chords is very similar to inputting notes in 
sequence (in that the caret must be active), but the input behavior is slightly different.

PROCEDURE

1. In bar 1, select the rest on the bottom staff.

2. Press Shift-N  to start note input.

3. Press Q  to start chord input.

● Chord input allows you to input multiple notes at the same position, that is, the caret 
position. In chord input, a + sign appears at the top of the caret.

● You can also start chord input by clicking Chords  in the Notes toolbox on the left of 
the window.

● As in the previous task, the default note duration of a quarter note (crotchet) is selected 
in the Notes panel. In this piece, the chords in the first few bars are all quarter notes, so 
you don’t need to change the duration.

Writing music
Inputting the chords on the bottom staff 
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4. Press A  to input an A♭.

● Because this is the first pitch on the staff, Dorico has no reference for register and 
chooses the A♭ closest to middle C, but this piece requires the A♭ below.

5. Press Ctrl/Cmd-Alt/Opt-Down Arrow  to transpose the selected A♭ down an octave.

● Alt/Opt-Down Arrow  transposes notes down by staff position, that is, by step. Adding 
Ctrl/Cmd  transposes notes down a larger amount, that is, by octave.

6. Press E  to input an E♭.
● In chord input, Dorico adds new notes above the previous note by default.

7. Press Space  to advance the caret.

● In chord input, the caret does not advance automatically, allowing you to build notes 
into chords at a single rhythmic position. Dorico expects chord input to continue until 
you stop it.

● Because the note duration currently selected is a quarter note, pressing Space 
advances the caret forward a quarter note.

● Now that Dorico has the first chord for pitch reference, the next A♭ would be input in the 
same octave as the first chord by default, which is not what the piece requires.

8. Press Shift-Alt/Opt-A  to input the A♭ above the note at the bottom of the previous chord, 
then press C  then E  to input the corresponding pitches as a chord above the A♭.

Writing music
Inputting the chords on the bottom staff 
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● Dorico automatically selects notes the smallest interval away from the previous note. 
Pressing Shift-Alt/Opt  as well as the letter for the note inputs that note above the 
previous note, regardless of the interval. For a lower note, it’s Ctrl-Alt (Windows) or 
Ctrl (macOS)  plus the letter for the note. If you’re not sure whether you need to specify 
the register, you can always transpose notes up/down octaves after inputting them.

9. Press Space  to advance the caret.

10. Press A , then C , then E  to input the corresponding pitches as a chord.

● The next bar is very similar to the first bar. However, it starts with the lower A♭ again.

11. Press Space  to advance the caret.

12. Press Ctrl-Alt-A (Windows) or Ctrl-A (macOS)  to input the A♭ below the note at the bottom 
of the previous chord, then press E  to input an E♭ above the A♭.

13. Press Space  to advance the caret.

14. Press B  to input a B♭, then Ctrl/Cmd-Alt/Opt-Up Arrow  to transpose the B♭ up an octave.

15. Press D , then E  to input the corresponding pitches above the B♭.
16. Press Space  to advance the caret.

17. Press B , then D , then E .

18. Press Space  to advance the caret.

19. Repeat steps 4 to 17 to input bars 3-4.

TIP

Alternatively, you can press Esc  to stop note input, select bars 1-2 on the bottom staff, then 
press R  to repeat the material directly after itself.

20. Press Esc  or Return  to stop note input.

RESULT
You have input all the chords required in the first four bars for the bottom staff.
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AFTER COMPLETING THIS TASK
Continue inputting chords on the bottom staff up until beat 1 in bar 6, as accidentals are 
required on beat 2 in bar 6.

Adding accidentals
So far, all the notes you have input have followed the accidentals in the key signature of A♭ major. 
However, the chords in bar 6 include B♮ and D♮, so you need to add accidentals.

PREREQUISITE
On the Note Input and Editing page in Preferences (key command Ctrl/Cmd-, ), you have 
chosen Before inputting note for Specify accidental, rhythm dot and articulations.

PROCEDURE

1. In bar 6, select the quarter note rest on beat 2 on the bottom staff.

2. Press Shift-N  to start note input.

3. If chord input is not already active, press Q  to start chord input.

● The F at the bottom of the chord does not need an accidental, but following on from the 
previous chord, the default register of the next F you input is a third below the A♭ on 
beat 1, rather than the sixth above that is required here.

4. Press Shift-Alt/Opt-F  to input an F in the correct, higher octave.

● The next two pitches both require a natural accidental, so you need to prepare the 
accidental before inputting each note.

5. Press 0  to select a natural accidental.

● You must press 0  on your computer keyboard, not a numeric keypad.

● You can also select a natural accidental by clicking Natural in the Notes panel on the left 
of the window.

6. Press B  to input a B♮.

● Accidentals only apply to one note. You must reselect a natural accidental for the D♮.
7. Press 0  to select a natural accidental.
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8. Press D  to input a D♮.
9. Press Space  to advance the caret.

10. Press F , then B , then D  to input the corresponding pitches.

● Because accidentals last for the rest of the bar by default, the next B and D are also input 
as B♮ and D♮ automatically.

11. Press Esc  or Return  to stop note input.

RESULT
You have input chords each containing two notes with natural accidentals. The natural 
accidentals are automatically hidden on the second chord because the default accidental 
duration rule in Dorico is common practice, where accidentals apply until the end of the bar. 
Similarly, the B♭ in bar 7 on the top staff shows a cautionary flat accidental automatically.

TIP

● You can also add accidentals to selected notes outside of note input. Sometimes this is more 
helpful, as you can add the same accidental to multiple notes at once.

For a flat accidental, press - . For a sharp accidental, press = . On an English keyboard, these 
keys have - (minus) and + (plus) on them respectively, which might help you remember them: 
minus lowers notes while plus raises notes. 0  for natural represents no alteration.

You can find more accidentals in the Key Signatures, Tonality Systems, and Accidentals 
panel on the right of the window, which you can show by clicking Key Signatures, Tonality 
Systems, and Accidentals  in the Notations toolbox.

● For more information about accidental duration rules, see the Operation Manual. In Dorico 
Elements and Dorico SE, you cannot change the accidental duration rule.

AFTER COMPLETING THIS TASK
Continue inputting chords on the bottom staff using what you have learned in this task and the 
previous task up until the first beat of bar 14, without the arpeggio signs: you will add those in a 
later task.

Adding another voice to the top staff
In bar 9, a second voice appears on the top staff, so you need to add an additional voice to the 
staff. We will also explain how you can identify the voice into which you are inputting notes.

PROCEDURE

1. In bar 9, select the rest on the top staff.

2. Press Shift-N  to start note input.

● Beside the caret, there is a note symbol. This indicates the voice to which anything you 
then input is assigned by showing its stem direction, a number, and type (normal, slash, 
or grace).
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● Currently, the note symbol shows you are inputting notes into the first up-stem voice on 
the staff, but this bar requires a down-stem voice.

3. If chord input is active, press Q  to stop chord input.

4. Press Shift-V  to create a new voice.

● A + sign appears beside the note symbol, whose stem now points down. This indicates a 
new down-stem voice.

5. Press 7  to select half notes (minims), then .  (period) to add a rhythm dot, making the 
duration dotted half notes.

6. Press B  to input a B♭ in the new down-stem voice.

● Dorico shows a cautionary ♭ accidental on the B due to the B♮s on the bottom staff in the 
previous bar.

● The caret automatically advances to the next bar. However, in this instance, there are 
still other notes in the up-stem voice in bar 9 that you need to input.

7. Press Left Arrow  until the caret is positioned at the start of the second beat in bar 9.

● When moving the caret using the arrow keys, how far it moves depends on the current 
rhythmic grid resolution (rather than the note duration selected in the Notes panel when 
you press Space ). The current rhythmic grid resolution  is shown in the status 
bar at the bottom of the window. By default, it’s set to eighth notes.

● The note symbol beside the caret indicates that it’s still set to the down-stem voice, but 
the eighth notes in bar 9 are in the up-stem voice.

8. Press V  to switch to the up-stem voice.
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● V  cycles through all active voices on the staff. As there are currently only two voices on 
the top staff, pressing V  switches between the up-stem and down-stem voices.

9. Press 5  to select eighth notes (quavers).

10. Press E , G , F , then E  to input the pitches E♭, G, F, and E♭ as eighth notes into the up-stem 
voice.

11. Press 7  then .  (period) to select dotted half notes (dotted minims).

12. Press Q  to start chord input.

13. Press Ctrl-Alt-A (Windows) or Ctrl-A (macOS)  to input the A♭ a fifth below, rather than a 
fourth above, the preceding E♭, then D  to input the D♭ above as a dotted half note chord into 
the up-stem voice.

14. At the start of bar 11, press V  to switch to the down-stem voice

15. Repeat steps 5 to 13 to input bars 11-12.

TIP

Alternatively, you can press Esc  to stop note input, select bars 9-10 on the top staff, then 
press R  to repeat the material directly after itself.

16. Press Esc  or Return  to stop note input.

RESULT
You have added a new down-stem voice and input all the notes required in bars 9-12 for the 
top staff. The order in which you input notes for each voice doesn’t matter: Dorico automatically 
updates stem directions and voice columns to accommodate voices.

AFTER COMPLETING THIS TASK
Input the notes in bar 13 on the top staff using what you have learned in this task, or copy them 
from bar 11.
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Adding slurs
Most phrases in this piece have slurs. This task starts by adding slurs to the phrases you have 
already input, then describes inputting a slur alongside new notes.

PROCEDURE

1. In bar 1, click anywhere on the eighth note beam on the top staff to select all notes in the 
beam.

2. Press S  to add a slur across the selected notes.

● You can also add slurs by clicking Slur  in the Notes panel on the left of the window.

3. Repeat steps 1 and 2 for each phrase that requires a slur, up to the end of bar 8.

● The slur across bars 9-10 joins notes in different voices, so you have to select these 
notes differently.

4. In bar 9, select the down-stem note.

5. Ctrl/Cmd -click at least one note in bar 10 on the top staff.

6. Press S  to add a slur between the selected notes.

7. Repeat steps 4 to 6 for the other cross-voice slurs in bars 11-13.
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● If you have Dorico Pro, in a later task you can flip these slurs and adjust their shape so 
they start on the rests.

● This is as far as you have input notes, so now you can input notes and slurs together.

8. Select the rest in bar 14 on the top staff.

9. Press Shift-N  to start note input.

10. If the note symbol beside the caret is down-stem, press V  to switch to the up-stem voice.

11. If chord input is active, press Q  to stop chord input.

12. Press 5  to select eighth notes (quavers).

13. Press S  to start a slur.

14. Input the notes under the first slur, up to the first eighth note (quaver) in bar 17.

15. Press Shift-S  to stop the slur without stopping note input.

16. Press F  to input the F at the start of the next phrase.

17. Press S  to start another slur on the currently selected note, that is, the F you just input.

18. Input the notes under the second slur, up to the end of bar 17.

19. Press 7  to select half notes, then .  (period) to add a rhythm dot, making the duration dotted 
half notes.

20. Press G .

21. Press Shift-S  to stop the slur.

22. Press Esc  or Return  to stop note input.

RESULT
You have added slurs to existing phrases, including cross-voice slurs, and input slurs alongside 
inputting notes.

AFTER COMPLETING THIS TASK
You can copy the music on both staves in bars 3-4 into bars 19-20.
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Inputting a tie
There is a tie that joins two notes on the bottom staff across the barline between bars 14 and 15. 
In these steps you will input that tie.

PROCEDURE

1. In bar 14, select the quarter note (crotchet) rest on beat 3 on the bottom staff.

2. Press Shift-N  to start note input.

3. If chord input is not already active, press Q  to start chord input.

4. Press 7  to select half notes (minims).

● We do mean half notes, despite the caret being at the last quarter note in the bar.

5. Press D  to input a half note D♭.

● Ta-dah! The half note D♭ automatically appears as two tied quarter notes.

6. Press Ctrl/Cmd-Alt/Opt-Up Arrow  to transpose it up an octave.

7. Press 6  to select quarter notes (crotchets).

8. Press F , then Space  to advance the caret.

9. Press -  to select a flat accidental, then F  to input an F♭.

10. Press Esc  or Return  to stop note input.
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RESULT
You have input a half note (minim) that is displayed as two tied quarter notes (crotchets). Dorico 
treats it as a single note, meaning if you click either notehead, both are selected.

TIP

In Dorico, in most cases you don’t need to input ties: simply select the total duration of the note, 
and Dorico splits it up into tied notes as appropriate for the time signature and its position in the 
bar. This applies to beam grouping as well as note grouping. If you do need to tie notes together 
manually, the key command is T ; to remove ties, the key command is U .

AFTER COMPLETING THIS TASK
You can input the rest of the notes on the bottom staff up to the end of bar 18. We recommend 
inputting the E at the end of bar 15 as a D♮; you will learn how to respell notes in a later task.

Adding dynamics
This piece includes a number of different dynamics, including ones such as , which are known 
as “immediate dynamics” in Dorico, and crescendo/diminuendo hairpins, which we collectively 
name “gradual dynamics”. Like slurs, you can add dynamics to existing music as well as inputting 
them during note input.

You can also input a slur during this task by starting the slur after step 13 and ending it between 
inputting the two Fs in step 17.

PROCEDURE

1. In bar 1, select the quarter note rest on the treble clef.

2. Press Shift-D  to open the dynamics popover.

3. Enter mp into the popover.

4. Press Return  to close the popover and input the  dynamic.

5. In bar 5, click the eighth note G on the top staff.

6. Press <  (that is, Shift - , ) to input a crescendo hairpin that spans the selected note, that is, 
an eighth note in duration.

● Dorico uses the < and > characters for crescendo and diminuendo hairpins respectively 
due to their similar appearance.
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● This hairpin should actually be longer, so you need to lengthen it.

7. Press Shift-Alt/Opt-Right Arrow  to lengthen the hairpin up to beat 2 in bar 6.

● The number of presses required depends on your rhythmic grid resolution .

TIP

● You can also shorten hairpins by pressing Shift-Alt/Opt-Left Arrow . These key 
commands apply to notes too, as well as all notations with duration, such as pedal lines, 
slurs, and gradual tempo changes.

● If you select a range of notes and then input a gradual dynamic, it spans the selection 
automatically.

● Now you can try inputting notes and dynamics at the same time.

8. In bar 21, select the bar rest on the top staff.

9. Press Shift-N  to start note input.

10. If chord input is active, press Q  to stop chord input.

11. Press 5  to select eighth notes (quavers).

12. Press Space  to advance the caret one eighth note, then press F  to input an F.

● If you have not already input the phrase in bars 19-20, the F might be input in the wrong 
octave. You can either press Ctrl-Alt-F (Windows) or Ctrl-F (macOS)  to specify the 
lower octave before you input it, or press Ctrl/Cmd-Alt/Opt-Down Arrow  to transpose 
it down an octave after inputting it.

13. Press <  (that is, Shift - , ) to start a crescendo hairpin.

● The hairpin is not visible yet, as it has no duration until you have advanced the caret. It 
will appear and extend as you input notes.

14. Press G , A , B , C , D , then E  to input the corresponding pitches.

● The hairpin extends as you input notes. Hairpins also extend when you press Space  to 
advance the caret.
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15. Press ?  (that is, Shift - / ) to stop the hairpin.

16. Press 6  to select quarter notes (crotchets).

17. Press F  twice to input two quarter note Fs.

18. Press Esc  or Return  to stop note input.

RESULT
You have added immediate and gradual dynamics to existing notes, and input gradual dynamics 
alongside inputting notes.

TIP

You can also add dynamics using the Dynamics panel on the right of the window, which you can 
show by clicking Dynamics  in the Notations toolbox.

Adding articulations
This piece includes a number of different articulations, including marcato, tenuto, and staccato 
marks. You can add articulations to existing notes as well as inputting them alongside notes.

PROCEDURE

1. Ctrl/Cmd -click the Gs in bars 2, 4, 18, and 20 on the top staff.

2. Press '  to add marcatos to all selected notes.

● You can also select articulations by clicking the corresponding button in the Notes panel 
on the left of the window. The key commands for articulations use the four keys to 
the left of the Return  key on the computer keyboard, matching their arrangement in 
the Notes panel. Combining Shift  with these keys allows you to access the lower four 
articulations in the panel.

3. Ctrl/Cmd -click the quarter note Fs on beat 3 in bars 6, 8, and 22.

4. Press ]  to add staccatos to all selected notes.
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● Now you can try inputting notes and articulations at the same time. The next articulation 
you need to input is at the end of bar 24, and because the phrase in bars 23-24 is the 
same as 21-22, you can copy most of it.

5. In bar 21, select the eighth note rest on the top staff.

6. Shift -click the F on beat 2 in bar 22 on the top staff to select everything on the top staff up 
to that note.

7. Alt/Opt -click the top staff at the start of bar 23.

● This copies the selected material to the closest position to the mouse pointer, as 
determined by the rhythmic grid resolution, without copying it to your clipboard. If your 
rhythmic grid resolution is very small, such as 32nd notes, you must be more precise 
where you Alt/Opt -click than if it’s set to a larger value, such as quarter notes.

8. In bar 24, select the quarter note rest on beat 3 on the top staff.

9. Press Shift-N  to start note input.

10. Press ]  to select staccatos.

11. Press F  to input an F with a staccato.

● Articulations are sticky in Dorico, which means all notes you input have the selected 
articulations until you deactivate them or stop note input. This is different to accidentals, 
where the selected accidental only applies to the next note you input.

12. Press ]  again to deactivate staccatos.

● The next steps skip ahead in the piece to demonstrate inputting consecutive notes with 
tenuto marks.

13. Press Ctrl/Cmd-Right Arrow  to move the caret to the next bar for each press until it 
reaches the start of bar 39.

14. Press # (Windows) or \ (macOS)  to select tenutos.

15. Press D , F , then B  to input the corresponding pitches with tenuto articulations.
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● There are also three quarter notes with tenuto marks on the bottom staff in this bar, so 
you need to move the caret back to input those notes too.

16. Press Ctrl/Cmd-Left Arrow  to move the caret back a bar to the start of bar 39.

17. Press Down Arrow  to move the caret to the bottom staff.

18. Press 0  to select a natural accidental, then G , F , then E  to input the corresponding pitches 
with tenuto articulations.

19. Press Esc  or Return  to stop note input.

RESULT
You have added articulations to existing notes and input notes with articulations.

Adding arpeggio signs to chords
Most of the chords in this piece are played straight, but a number are rolled, which is indicated 
with an arpeggio sign. You can add arpeggio signs to existing chords as well as inputting them 
alongside inputting notes.

PREREQUISITE
You have input all the chords in the bottom staff up to the end of bar 11.

PROCEDURE

1. In bar 9, click the stem of the chord on beat 1 on the bottom staff to select all notes in the 
chord.

● Arpeggio signs apply automatically to all notes in the voice, so you can even select just a 
single note in the chord.

● You can only add arpeggio signs to a single chord at a time.

2. Press Shift-O  to open the ornaments popover.
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3. Enter arp into the popover.

4. Press Return  to close the popover and input an arpeggio sign across all notes in the 
selected chord.

5. Repeat steps 1 to 4 for the chords on beat 1 in bars 11, 13, and 14.

● Now you can try inputting an arpeggio sign alongside a chord.

6. In bar 26, select the bar rest on the top staff.

7. Press Shift-N  to start note input.

8. If chord input is not already active, press Q  to start chord input.

9. Press Shift-O  to open the ornaments popover.

10. Enter arp into the popover.

11. Press Return  to close the popover and input an arpeggio sign at the rhythmic position of 
the caret.

12. Press A  to input an A♭.

● When you input the A♭, a short arpeggio sign appears to the left of the note.

● Based on the previous pitches in this voice on the staff, Dorico inputs the A♭ at the top of 
the chord.

13. Press Ctrl-Alt-E (Windows) or Ctrl-E (macOS) , then Ctrl-Alt-A (Windows) or Ctrl-
A (macOS)  to input the corresponding pitches below the top A♭.
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● When you input the E♭ then another A♭ below, the arpeggio automatically extends across 
all three notes.

14. Press Esc  or Return  to stop note input.

RESULT
You have added arpeggio signs to existing chords and input an arpeggio sign alongside 
inputting a new chord.

TIP

You can also add arpeggio signs using the Ornaments panel on the right of the window, which 
you can show by clicking Ornaments  in the Notations toolbox.

Adding tempo marks
Because this piece was composed in the Romantic era, it includes a fair amount of rubato. This is 
indicated in the music with relatively short fluctuations in tempo, including a ritardando followed 
by an a tempo, which you will input in this task.

Now that you have completed several tasks, you have probably correctly worked out that you can 
input tempo marks both during note input and by adding them to existing music. During note 
input, they are input at the caret position. However, gradual tempo changes, such as accelerando, 
do not extend as you input notes.

PROCEDURE

1. In bar 11, select any note on beat 2.

● Because tempo marks are system objects and apply to all systems in a layout, you can 
select notes on either staff that span the required duration.

2. Ctrl/Cmd -click the chord on beat 3 in bar 12.

3. Press Shift-T  to open the tempo popover.

4. Enter poco rit. into the popover.

5. Press Return  to close the popover and input a poco rit. gradual tempo change that spans 
the selected range.

● A continuation line is automatically shown for its duration. The circular handles at the 
start and end control its rhythmic start and end positions.
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6. In bar 13, select any of the notes or the rest on beat 1.

7. Press Shift-T  to open the tempo popover.

8. Enter a tempo into the popover.

9. Press Return  twice to select your entry and input it.

RESULT
You have added a gradual tempo change and an absolute tempo change. Dorico automatically 
aligns the ritardando continuation line with the “A tempo” marking.

TIP

You can also add tempo marks using the Tempo panel on the right of the window, which you can 
show by clicking Tempo  in the Notations toolbox.

AFTER COMPLETING THIS TASK
Using the tempo popover ( Shift-T ), input a Grazioso tempo mark at the start of bar 1. If you 
input the version with a suggested metronome mark, you can hide the metronome mark by 
selecting it and deactivating Metronome mark in the Tempo group of the Properties panel at 
the bottom of the window (press Ctrl/Cmd-8  to hide/show it).

Dorico aligns the Grazioso tempo mark with the time signature automatically.
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Adding clef changes
In this piece, the register on the staff changes drastically enough in some places to justify a 
change in clef. The first clef changes are at the end of the first section of the piece.

PROCEDURE

1. In bar 28, select the rest on the top staff.

2. Press Shift-N  to start note input.

3. If chord input is not already active, press Q  to start chord input.

4. Press F , C , then F  to input the corresponding pitches as a quarter note chord.

5. Press Space  to advance the caret.

6. Press Shift-C  to open the clefs and octave lines popover.

7. Enter bass into the popover.

8. Press Return  to close the popover and input a bass clef at the caret position.

9. Continue inputting notes and chords on the top staff until the end of bar 29.

● To select flat accidentals for each F♭ on beat 3 in bar 28, press - .

● When you add a chord in the down-stem voice on beat 3 in bar 29, rests appear on beats 
1 and 2. In the next task, you can delete them.

10. Press Esc  or Return  to stop note input.

11. In bar 30, select the rest on the top staff.

12. Press Shift-C  to open the clefs and octave lines popover.

13. Enter treble into the popover.

14. Press Return  to close the popover and input a treble clef at the selected rhythmic position.
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RESULT
You have input two clef changes plus the notes and chords required on the top staff in bars 
28-29.

TIP

You can also add clefs using the Clefs panel on the right of the window, which you can show by 
clicking Clefs  in the Notations toolbox.

Deleting rests
Dorico automatically shows rests between the notes you input, as appropriate for the prevailing 
time signature and their position in the bar. When using voices to notate passing notes, as in bar 
29, rests in those voices are not always wanted. In such cases, you can delete rests.

PROCEDURE

1. In bar 29, click on the staff to select all items in the bar.

2. Choose Edit > Remove Rests.

RESULT
All rests within the selection are removed. This is done by automatically activating the Starts 
voice and Ends voice properties in the Notes and Rests group of the Properties panel on the 
required notes so that no rests are shown in the selected region.
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Inputting tuplets
In bars 30-40, there are several different tuplets that you must input. Dorico allows you to input 
tuplets with any ratio, including over barlines.

PROCEDURE

1. In bar 30, select the rest on the top staff.

2. Press Shift-N  to start note input.

3. If chord input is active, press Q  to stop chord input.

4. Press ;  to open the tuplets popover.

5. Enter 5:4x into the popover.

● Tuplets are expressed as ratios: the number of notes in the tuplet, followed by the 
number of normal notes the tuplet lasts for, separated by a colon. For example, 5:4 
means five notes in the space of four (a quintuplet), 3:2 means three notes in the space 
of two (a triplet). The letter after the ratio specifies the beat unit. For example, x for 
16th notes, e for eighth notes, q for quarter notes. If you don’t specify the beat unit in 
your popover entry, the tuplet is based on the note value currently selected in the Notes 
panel.

6. Press Return  to close the popover and input a 16th note (semiquaver) quintuplet.

7. Press 4  to select 16th notes (semiquavers).

● You can input notes of any duration inside tuplets of any ratio. If the note is too long to 
fit, any extra duration is notated beyond the tuplet.

8. Press F , D , Ctrl-Alt-G (Windows) or Ctrl-G (macOS)  to input the G below, Shift-Alt/Opt-D 
to input the D♭ above, then F .

● Tuplets are sticky in Dorico, which means you continue to input the specified tuplet until 
you stop tuplet input or note input.
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● Dorico shows a cautionary ♭ accidental on the first D due to the D♮s in the previous bar.

9. Press :  (that is, Shift - ; ) to stop tuplet input.

● Shift - ;  stops tuplet input just like Shift-S  stops slurs and Shift - /  stops gradual 
dynamics.

10. Press 6  to select quarter notes (crotchets).

11. Press B , then C .

12. Repeat steps 4 to 11 for bar 31.

TIP

Alternatively, you can press Esc  to stop note input, select bar 30 (without the treble clef), 
press R  to repeat the material directly after itself, then press Ctrl/Cmd-Alt/Opt-Up Arrow 
to transpose it up an octave.

13. Press Esc  or Return  to stop note input.

● Now you can try inputting consecutive triplets.

14. In bar 40, select the rest on the bottom staff.

15. Press Shift-N  to start note input.

16. Press ;  to open the tuplets popover.

17. Enter 3:2e, for three eighth notes in the space of two, into the popover.

18. Press Return  to close the popover and input an eighth note triplet.

19. Press 5  to select eighth notes (quavers).

20. Press A  to input an A♭.
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● Based on the preceding pitches, this inputs an A♭ that is two octaves too high.

21. Press Ctrl/Cmd-Alt/Opt-Down Arrow  twice to transpose it down to the correct octave.

22. Press Shift-Alt/Opt-E  to input the E♭ a fifth above, rather than a fourth below, the preceding 
A♭, then A , C , E , then A  to input the corresponding pitches as triplet eighth notes.

23. Press :  (that is, Shift - ; ) to stop tuplet input.

24. Press Shift-C  to open the clefs and octave lines popover.

25. Enter treble into the popover.

26. Press Return  to close the popover and input a treble clef at the caret position.

27. Press 6  to select quarter notes (crotchets).

28. Press C  to input a quarter note C.

29. Press Esc  or Return  to stop note input.

RESULT
You have input two different types of tuplets and an additional clef change. In a later task, you 
can change the direction of stems in bars 30-31.
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Adding a grace note
In bar 32, there is a grace note before a chord on the top staff. In this task, you will input the 
chords on the top staff in bar 32 including the grace note.

PROCEDURE

1. In bar 32, select the rest on the top staff.

2. Press Shift-N  to start note input.

3. If chord input is not already active, press Q  to start chord input.

4. Press Ctrl-Alt-C (Windows) or Ctrl-C (macOS) , E , then A  to input the chord.

5. Press Space  to advance the caret.

6. Press /  to start grace note input.

● In grace note input, the caret appears a bit shorter than in standard note input.

● You can also activate grace note input by clicking Grace Notes  in the Notes toolbox 
on the left of the window.

7. Press 5  to select eighth notes (quavers).

8. Press B  to input a B♭ grace note.

9. Press Ctrl/Cmd-Alt/Opt-Up Arrow  twice to transpose it up two octaves.

10. Press /  to stop grace note input.
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● The caret gets larger and appears to advance a little as it returns to normal note 
position. It had stayed at the grace note position because chord input was active.

11. Press 7  to select half notes (minims).

12. Press Ctrl-Alt-C (Windows) or Ctrl-C (macOS) , E , then A .

13. Press Esc  or Return  to stop note input.

RESULT
You have input a grace note alongside the required chords on the top staff in bar 32.

Adding an octave line
To avoid having lots of ledger lines, the chord you input in bar 32 that jumps up an octave can be 
notated with an 8va octave line, that is, an octave line that indicates notes are played an octave 
higher than written.

PROCEDURE

1. In bar 32, click the grace note on the top staff, then Shift -click the chord on beat 2.

2. Press Shift-C  to open the clefs and octave lines popover.

3. Enter 8va into the popover.
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4. Press Return  to close the popover.

RESULT
An 8va octave line that spans the grace note and chord is input. All notes within the span of the 
octave line are automatically notated an octave lower than before you input the octave line.

The octave line’s endpoint is attached to the start of the next bar, as indicated by the dotted 
red line, but its continuation line ends to the right of the chord. This follows conventions for the 
length and placement of octave lines.

TIP

You can also add octave lines using the Clefs panel on the right of the window, which you 
can show by clicking Clefs  in the Notations toolbox. They share a panel with clefs as both 
notations alter where on staves notes appear.

Inputting the music in bars 33-35
Bars 33-35 include cross-staff beams (beams that start on the bottom staff but end on the top 
staff) and chords with alternative note spellings. In this task, you will input all the notes and 
chords required in these bars, and then in the next two tasks you will cross notes from the 
bottom staff to the top staff and respell notes to show the Bs.

PROCEDURE

1. In bar 33, select the rest on the bottom staff.

2. Press Shift-N  to start note input.

3. If chord input is active, press Q  to stop chord input.

4. Press ;  to open the tuplets popover.

5. Enter 3:2x into the popover.

6. Press Return  to close the popover and input a 16th note triplet.

7. Press 4  to select 16th notes (semiquavers).

8. Press D  to input a D♭, then Ctrl/Cmd-Alt/Opt-Down Arrow  twice to transpose it down two 
octaves.

Writing music
Inputting the music in bars 33-35 

43
Dorico 3.5.12



9. Press Shift-Alt/Opt-A  to input the A♭ a fifth above, rather than a fourth below, the preceding 
D♭, then D  to input the D♭ a fourth above that.

10. Press :  (that is, Shift - ; ) to stop tuplet input.

11. Press 3  to select 32nd notes (demisemiquavers).

12. Press F , A , D , then F  to input the corresponding pitches.

13. Press 6 , then A  to input a quarter note A♭.
14. Press Q  to start chord input.

15. Press Ctrl-Alt-D (Windows) or Ctrl-D (macOS)  to input a D♭ a fifth below, rather than a 
fourth above, the previous A♭, then 0 , E , 0 , G , 0 , then A .

● This inputs the chord on beat 3 with the required natural accidentals. You will respell the 
A♮ into a B later.

16. Press Up Arrow  to move the caret to the top staff.

17. Press ' , 0 , then Ctrl-Alt-E (Windows) or Ctrl-E (macOS) .

● This selects the marcato articulation, natural accidental, and inputs an E♮ a sixth below, 
rather than a third above, the preceding note on the top staff (that is, the C at the 
bottom of the chord in bar 32).

18. Press Esc  or Return  to stop note input.

● Bar 33 should now look like this:
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19. Select everything in bar 33 then press R  twice to repeat it in bars 34 and 35.

20. Select everything in bars 33-35 then choose Edit > Remove Rests.

● A quick way of selecting everything in bars 33-35 is to click on the bottom staff in bar 33, 
but not on the notes, then Shift -click on the top staff in bar 35, also not on the notes.

RESULT
You have input the notes and chords required for bars 33-35 and removed the rests. Removing 
rests was necessary here because the chords will behave as if they were in a down-stem voice 
when you cross them to the top staff. When cross-staff music only involves a single voice, 
removing rests is not necessary: Dorico hides them as required automatically.

Crossing notes to the other staff
In Dorico, you can achieve cross-staff beams for phrases that span multiple staves by inputting 
all the notes on one staff and then crossing some to the other. In the previous task, you input the 
notes so now you can cross them.

PROCEDURE

1. In bar 35, select the A♮ at the top of the chord on beat 3.
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2. Press Alt/Opt-N  to move the note so it belongs to the top staff.

● The A♮ is merged into the up-stem voice with the existing E♮. However, this removes the 
marcato articulation.

3. Press '  to re-input the marcato articulation.

4. In bar 33, select the 32nd note (demisemiquaver) D♭, then Shift -click the chord on beat 3.

5. Press N  to cross the selected notes to the staff above.

6. Repeat steps 4 and 5 for bars 34-35.
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RESULT
The notes are crossed from the bottom staff to the top staff with centered cross-staff beams 
and appropriate stem directions automatically. Notes crossed to other staves still belong to their 
home staff, but appear on the other.

TIP

● The key commands for moving notes to other staves use the same keys as crossing notes 
to other staves, plus the Alt/Opt  key: moving notes to the staff above ( Alt/Opt-N ) and 
crossing notes to the staff above ( N ) both involve upwards movement, while moving notes 
to the staff below ( Alt/Opt-M ) and crossing notes to the staff below ( M ) both involve 
downwards movement.

● You could also Ctrl/Cmd -click the relevant notes in bars 33-35 and cross them all to the staff 
above together, but this can be slower than separate Shift -clicked selections.

Respelling notes
In bars 33-34, you input A♮s that were notated as Bs in the original edition, and a D♭ in bar 35 
that was originally notated as a C♯. In this task, you can respell these notes.

PROCEDURE

1. In bars 33 and 34, select the A♮s in the down-stem chord on beat 3.

2. Press Alt/Opt-=  to respell them using the note above and notate them as Bs.

3. In bar 35, select the D♭ at the bottom of the down-stem chord on beat 3.

4. Press Alt/Opt--  to respell it using the note below and notate it as C♯.
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RESULT
The A♮s are respelled upwards and the D♭ is respelled downwards.

TIP

● The key commands for respelling notes use the same keys as adding accidentals, plus the 
Alt/Opt  key: respelling upwards ( Alt/Opt-= ) and sharp accidentals ( = ) both involve raising 
notes, while respelling downwards ( Alt/Opt-- ) and flat accidentals ( - ) both involve lowering 
notes.

● You can find more accidentals than ♭, ♮, or ♯ in the Key Signatures, Tonality Systems, 
and Accidentals panel on the right of the window, which you can show by clicking Key 
Signatures, Tonality Systems, and Accidentals  in the Notations toolbox.

So instead of inputting an A♮ then respelling it, you could input a B straightaway.

Adding indications for left/right hands
To clarify which hand should play notes when they are notated on the same staff, the original 
edition has “l.H.” and “r.H.” indications, for “left hand” and “right hand” respectively, above and 
below the staff.

PROCEDURE

1. In bar 30, select the B♭ on beat 2 on the top staff.

2. Press Shift-X  to add staff text and open the text editor.

● You can also add staff text by clicking Text  in the Notations toolbox. To open the text 
editor for an existing text object, select it and press Return .

3. Enter l.H..

4. Select the “l.H.” text in the text editor then select the Italic font style from the editor options.

Writing music
Adding indications for left/right hands 

48
Dorico 3.5.12



5. Press Esc  or Ctrl/Cmd - Return  to close the text editor.

6. Select the “l.H.” text and press F  to flip it below the staff.

7. Repeat steps 1 to 5 for the “r.H.” indication, but in step 1, select the C on beat 3.

8. Ctrl/Cmd -click both text objects, then Alt/Opt -click the staff on beat 2 in bar 31 to copy 
them at that position.

RESULT
You have added text objects that indicate the left and right hands, formatted the text as italics, 
and flipped the “l.H.” indication below the staff.
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Adding the repeat ending
Repeat ending structures in Dorico automatically incorporate the lines above the staff and the 
repeat barline. In the original edition, the second ending has a closed hook end so you can also 
replicate that.

PROCEDURE

1. In bar 39, select any note on the first beat.

2. Shift -click anything that lasts until the end of bar 40, such as the note on beat 3 on the 
bottom staff or the bar rest on the top staff.

3. Press Shift-R  to open the repeats popover.

4. Enter end or ending into the popover.

5. Press Return  to close the popover and input a repeat ending where the first ending spans 
the duration of your selections and the second ending lasts one bar.

6. Select the repeat ending and press Shift-Alt/Opt-Right Arrow  to lengthen the second 
ending so it lasts two bars.

7. In the Properties panel at the bottom of the window, activate End of line in the Repeat 
Endings group and select Closed from the menu to give the line a hook end.
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● If the Properties panel isn’t shown, press Ctrl/Cmd-8  to show it.

RESULT
You have added the repeat ending, lengthened the duration of the second ending, and changed 
its end so the second ending has a hook. Dorico inputs a repeat barline at the end of the first 
ending automatically.

Finish writing the music
You should now have input a decent portion of the whole piece, and by following the previous 
tasks, learned how to do everything required to complete Dora Pejačević’s “Walzer-Capricen 
No. 2”.

Now you can finish inputting the full piece by referring to the complete score (available on 
steinberg.help). Here are some reminders and tips to help you finish:

● The music from bar 43 to the end is almost an exact repetition of bars 1-32. If you first 
finish everything required in bars 1-32, you can simply copy that to bar 43 and check for any 
differences, tweaking the duplicated material as required.

NOTE

In the original edition, the clef changes in bars 28-30 were not included when material 
returns in bars 70-72, presumably to save horizontal space in that system. You can decide for 
yourself whether to include the clef changes the second time!

● There are many more dynamics and slurs in the piece than were included in these steps, so 
you can add the rest of those.

● If you input anything in the wrong place or voice, you can easily move and lengthen/shorten 
notes and items:

● To move notes/items rhythmically to the right, press Alt/Opt-Right Arrow . To move 
them to the left, press Alt/Opt-Left Arrow . (These key commands move dynamics to 
noteheads. To move dynamics by the rhythmic grid instead, press Ctrl/Cmd-Alt/Opt-
Right Arrow  or Ctrl/Cmd-Alt/Opt-Left Arrow .)

● To lengthen notes and items with duration, like hairpins, press Shift-Alt/Opt-
Right Arrow . To shorten them, press Shift-Alt/Opt-Left Arrow .

● To move notes/items to the staff above, press Alt/Opt-N . To move notes/items to the 
staff below, press Alt/Opt-M .

● To change the voice of notes, such as from an up-stem voice to a down-stem voice, 
select the notes and choose Edit > Voices > Change Voice > [Voice]. You can also 
choose this option from the context menu.

● To flip items so they appear on the other side of the staff, press F .

● Likewise, you can specify the register of notes before inputting them and change their pitch 
after inputting them:
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● To input a note above the previous note, press Shift-Alt/Opt  plus the letter for the 
note, for example, Shift-Alt/Opt-A . To input a note below the previous note, press 
Ctrl-Alt (Windows) or Ctrl (macOS)  plus the letter for the note, for example, Ctrl-Alt-
A (Windows) or Ctrl-A (macOS) .

● To raise notes by staff position, such as C to D, press Alt/Opt-Up Arrow . To lower notes 
by staff position, such as D to C, press Alt/Opt-Down Arrow .

● To raise notes by octave divisions, press Shift-Alt/Opt-Up Arrow . To lower notes 
by octave divisions, press Shift-Alt/Opt-Down Arrow . (The amount depends on the 
prevailing tonality system: half-steps (semitones) in 12-EDO or quarter tones in 24-EDO.)

● To raise notes an octave, press Ctrl/Cmd-Alt/Opt-Up Arrow . To lower notes an octave, 
press Ctrl/Cmd-Alt/Opt-Down Arrow .

● You shouldn’t need to input rests anywhere: just move the caret to where the notes should 
be, and Dorico will show any required rests around them.

● To start note input on a specific beat, double-click the staff at that position.

● To advance the caret according to the note duration currently selected in the Notes 
panel, press Space . This also extends notations with duration, such as gradual 
dynamics, and continues any prevailing tuplets.

● To move the caret according to the current rhythmic grid resolution , press 
Right Arrow / Left Arrow .

● To move the caret to the next/previous bar, press Ctrl/Cmd-Right Arrow / Ctrl/Cmd-
Left Arrow .

● To move the caret to the staff above/below, press Up Arrow / Down Arrow .

● To move the caret to the top/bottom staff in the system, press Ctrl/Cmd-Up Arrow /
Ctrl/Cmd-Down Arrow .

● The key commands for accidentals are -  for flat, 0  for natural, and =  for sharp. You don’t 
have to specify accidentals if they’re included in the key signature.

● The key commands for common note durations are 5  for eighth notes (quavers), 6  for 
quarter notes (crotchets), 7  for half notes (minims), and .  (period) for rhythm dots. Shorter 
durations have smaller numbers, longer durations have larger numbers.

● You can use the arrow keys to navigate around items in the music area, and press Tab  to 
switch the selection to other types of items at the same position, such as from a note to a 
dynamic or slur.
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Laying out and formatting 
pages

Once you have input all the notes and notations required, you can lay out and format pages to 
produce practical sheet music.

The following tasks take you through the steps required for this process. You can do most of the 
top-level changes in any mode and product version, but some tasks are only possible in Engrave 
mode in Dorico Pro.

If you have completed all the steps in the Writing music section and finished off the piece, or 
downloaded the completed but unformatted Dorico project from steinberg.help, your project 
should look something like this:

To produce practical performance material, the following tasks will result in the piece fitting 
on two pages, allowing it to fit comfortably on music stands without page turns. The tasks 
demonstrate achieving this using primarily the available default options, without much tweaking 
on individual pages.

TIP

● Many of the following tasks involve the Layout Options dialog, and at the end of each task 
you have the option to Apply your changes and Close the dialog. However, you can apply 
changes without having to close Layout Options, which is particularly useful if you have the 
dialog open on a second display. You could keep the dialog open until the end of Starting on 
a left-hand page rather than closing and reopening it between tasks.

● We recommend resetting the full score layout to the factory default layout options. You 
can do this in Layout Options ( Ctrl/Cmd-Shift-L ) by clicking Reset to Factory at the 
bottom of the dialog. If you have existing saved defaults, you must press Ctrl (Windows) 
or Opt (macOS)  to access the Reset to Factory button.
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Adding the title and composer
You need to add title and composer information for the project. On page 1, there are two 
different titles: the project title (“Untitled Project 1”, most likely) and the flow title (“Flow 1”).

The project title and flow title are separate because Dorico allows you to have multiple separate 
pieces of music, known as “flows”, in the same project. For example, you might have a project 
called “Symphony in G” that has four movements, each a separate flow. In this project, there is 
only one flow.

PROCEDURE

1. Press Ctrl/Cmd-I  to open the Project Info dialog.

● You can also open the Project Info dialog by choosing File > Project Info.

2. With Project selected in the list on the left, in the Title field, enter Walzer-Capricen No. 2.

3. In the Composer field, enter Dora Pejačević.

NOTE

Enter the accented characters directly, such as from the character map (Windows) or emoji 
and symbols character viewer (macOS), rather than pasting them in.

4. In the list on the left, select Flow 1.

5. At the bottom of the dialog, make sure Project is selected for Copy info from.

6. Click Copy to copy all information from the Project to Flow 1.

7. Click Apply, then Close.

RESULT
The title and composer for both the project and flow 1 are updated.
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Because the project title and flow title are referred to in different places using tokens by default, 
sometimes it is easiest to give both the project and the flow the same information in Project 
Info, rather than changing the tokens used in different places.

Master pages and tokens
Although you can only edit and use master pages and text tokens fully in Dorico Pro, it is worth 
understanding the basic principles of how Dorico uses them to display information on pages, 
regardless of your product version.

When you added information in Project Info, that information automatically appeared in the 
music. This affected the following information:

1 Project title

2 Flow heading, displaying the number and title of Flow 1

3 Project composer

4 Running header, displaying the title of Flow 1

The flow heading and running header both refer to the flow title, rather than the project title, 
so that they can update automatically according to the nearest flow below them. If your project 
contained four flows, for example, this means you could use the same page formatting on all 
pages and the flow titles always refer to the relevant flow.

Dorico achieves this by using text tokens that refer to fields in Project Info. Text tokens 
automatically populate with the corresponding information, such as flow titles or layout names. 
You might also know them as “wildcards”.

In Dorico Pro, the green text frames on the default master pages that contain these tokens are 
shown when you switch to Engrave mode:
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Master pages function like templates in Dorico, allowing the same page formatting to be applied 
to multiple different pages and in different layouts. All pages in your scores and parts inherit 
their page formats from master pages. Whenever you create or change anything on master 
pages, this is automatically reflected on the pages that use these master pages.

The project title and composer are both on the First master page. The running header is on the 
Default master page. The flow heading is shown above the first system in the flow, inside the 
music frame.

If you enter the top text frame on page 1, by either double-clicking it or selecting the edge and 
pressing Return , the token that populates with the project title is shown:

NOTE

● If you edit frames directly on the page, you create a master page override. If you want to 
make changes to frames that come from master pages, we recommend that you edit the 
master page itself. If you want to make the same change on lots of pages, this means you 
only have to make the change once to update all pages.

● The default frames on master pages use paragraph styles to format the corresponding type 
of text consistently. You can edit paragraph styles in Dorico Pro by choosing Engrave > 
Paragraph Styles.

● In Dorico Pro, you can right-click inside text frames to access tokens via the context menu.

Hiding the flow heading
Because there is only a single flow in this project, you can hide the flow heading as it duplicates 
the project title. If your project contained all nine pieces in Pejačević’s Opus 28 “Walzer-Capricen”, 
you would most likely want to show flow headings above each piece.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. Click Page Setup in the category list.

3. In the Flows section, choose Never for Show flow headings.

4. Click Apply, then Close.
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RESULT
All flow headings in the layout are hidden. However, this doesn’t hide the running header at the 
top of pages 2-4.

TIP

● For projects with more than one layout, make sure you select the required layouts in the list 
on the right before changing options.

● As tempting as it might be if you have Dorico Pro to switch to Engrave mode, select the flow 
heading frame, and press Backspace or Delete , it is better to hide the flow heading using 
this method: it doesn’t produce a master page override and hides all flow headings in the 
layout, meaning you don’t have to delete each one.

Hiding staff labels
As this piece only contains a single piano, hiding staff labels increases the available horizontal 
space for the music without losing useful information. Because it is an engraving tradition to 
indent the first system in parts slightly, you will add a small first system indent too.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. Click Staves and Systems in the category list.

3. In the Staff Labels section, choose None for both of the following options:

● Staff labels on first system

● Staff labels on subsequent systems

4. For Indent first system of flow by [n] spaces, enter 6.

5. Click Apply, then Close.

RESULT
Staff labels are hidden on all systems in the layout, and the first system is indented by 6 spaces.
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Changing the page size and margins
The next thing you can do to increase the available space on each page for music is to change 
the page margins. You can also change the page size to A4 so it’s the same as in our example.

In Dorico, there are the following types of margins:

● Page margins for all four edges, which control the available area for frames. Frames cannot 
go beyond page margins.

● Music frame margins at the top and bottom of music frames, which control the gaps 
between the top and bottom of music frames and the top and bottom staff lines. Very high 
and very low notes extend into music frame margins, so in a very low cello part, for example, 
you might want a larger bottom music frame margin.

TIP

● You can change your Preferred unit of measurement on the General page in Preferences 
(key command Ctrl/Cmd-, ). This task uses millimeters and inches.

● You can press Tab  to select the next value field in options dialogs.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. Click Page Setup in the category list.

3. In the Page Size section, select A4 from the Size menu.

4. In the Page Margins section, change the page margins:

● For Top, enter 11 mm or 0.433 inches.

● For Bottom, enter 12 mm or 0.473 inches.

● For Left, enter 14 mm or 0.551 inches.

● For Right, enter 14 mm or 0.551 inches.
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5. In the Music Frame Margins section, change the music frame margins:

● For Top, enter 12 mm or 0.473 inches.

● For Bottom, enter 8 mm or 0.315 inches.

6. Click Apply, then Close.

RESULT
The margins on all pages in the layout are changed and the page size is set to A4. A combination 
of this change and hiding the staff labels in the previous task causes the casting off (the 
distribution of music into systems and pages) to update automatically.

Deleting the copyright text frame (Dorico Pro only)
By default, Dorico includes a text frame for the copyright notice at the bottom of the First master 
page (used for the first page of music). This piece does not require a copyright notice, so Dorico 
Pro users can delete it to increase the vertical space available for music and keep the bottom 
staves aligned across all pages.

PROCEDURE

1. Switch to Engrave mode by either pressing Ctrl/Cmd-3  or clicking Engrave in the toolbar.

2. In the Pages panel on the right of the window, double-click First in the Master Pages 
section.

● If the right panel isn’t shown, press Ctrl/Cmd-9  to show it.

● This opens the First master page in the master page editor.
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3. Select the copyright text frame at the bottom of the page on the right.

● Master pages in Dorico act as page pairs, allowing odd-numbered, right-hand pages 
to look different to even-numbered, left-hand pages if necessary. You could select the 
copyright frame on the left page as well, but then in step 7 you would need to click the 
other button.

4. Press Backspace or Delete  to delete the frame.

5. Select the middle handle on the bottom edge of the music frame on the right page.

● You can do this by clicking anywhere on the frame edge to select the whole frame and 
show the handles, then click the middle handle. Or, when the whole frame is selected, 
press Tab  to switch to having the handle in the top left corner selected, then press 
Down Arrow  twice and Right Arrow  once until the bottom middle handle is selected.

6. Click and drag it down to the bottom page margin.
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● You can also press Ctrl/Cmd-Alt/Opt-Down Arrow  until it reaches the bottom page 
margin.

7. At the top of the music area, click Copy right to left .

● If you deleted the copyright frame on the left page, click Copy left to right  instead.

8. At the top right of the music area, click Apply, then Close.

RESULT
The copyright text token is removed from both sides of the First master page, and the music 
frame now extends to the bottom of the page. Page 1 in the layout automatically updates 
accordingly because it uses the First master page and doesn’t have any master page overrides 
that would prevent it picking up changes to the master page.

Changing the staff size
Staff size is determined using either the height of each space or the height of the staff overall, 
for which there are traditional rastral sizes. Finding the most appropriate staff size is often the 
quickest way to improve the look of scores, such as when the size is too large and systems start 
to overlap.

Although 7 mm is the most commonly used staff size for part layouts, a slightly smaller 6.5 mm 
staff size is still fine for a pianist to read from and will further reduce the pages required. Larger 
staff sizes are popular among players whose instruments require them to be further from the 
stand, such as trombone or contrabass players

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. Click Page Setup in the category list.

3. In the Space Size section, select Size 4 (6.5mm) from the Rastral size menu.

4. Click Apply, then Close.

RESULT
The staff size is reduced, and now the piece fits on three pages.
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Changing vertical spacing settings
Next, you can reduce the default vertical spacing settings to reduce the minimum amount of 
space Dorico allows for staves and systems.

Dorico automatically performs collision avoidance calculations for high or low notes, dynamics, 
text, and so on. These gaps change the spacing in addition to collision avoidance.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. Click Vertical Spacing in the category list.

3. In the Ideal Gaps section, for Braced staff to braced staff, enter 4 7/8.

4. For Inter-system gap, enter 8.

5. Click Apply, then Close.

RESULT
All staves and systems move closer together, getting the page count close to two.
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Changing note and cross-staff beam spacing
In order to fit the remaining music on page 3 onto pages 1-2, you can reduce the minimum note 
spacing to fit more bars in each system. At the same time, you can make the gaps between stems 
equal for the cross-staff beams.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. Click Note Spacing in the category list.

3. For Default space for crotchet/quarter note, enter 3 1/4.

4. For Minimum space for short notes, enter 1 1/2.

● Alternatively, click the down arrow to the right of the value field until you reach this 
value.

5. Activate Optical spacing for beams between staves.

6. Click Apply, then Close.

RESULT
The minimum horizontal space between notes is reduced, allowing more bars to fit in each 
system and bringing the whole piece onto two pages. If that’s not the case for you, try adjusting 
the parameters covered in the previous tasks slightly until it does.

The cross-staff beams in bars 33-35 now have optical spacing, meaning the gaps between stems 
are equal, rather than between noteheads. On balance, this piece looks better with equally 
spaced stems and larger gaps between noteheads, but you might find equally spaced noteheads 
preferable in other contexts.
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Starting on a left-hand page
As this layout now fits on two pages, it makes sense to set it up as a two-page spread with the 
first page on the left and the second page on the right.

PROCEDURE

1. Press Ctrl/Cmd-Shift-L  to open Layout Options.

2. Click Page Setup in the category list.

3. In the Page Numbers section, enter 2 for Initial page number.

4. Click Apply, then Close.

RESULT
The initial page number is changed, and the previous page 2 becomes page 3. Because it is now 
an even number, Dorico automatically treats it as a left-hand page and the layout is updated 
in the music area to show adjoining pages. The second page is now formatted as a right-hand 
page, meaning the page number appears in the top right of the page rather than the top left.

TIP

● The repeat ending at the top of page 2 sits quite close to the running header and page 
number now it’s positioned in the top right corner. If you have Dorico Pro, you can edit 
the Default master page (like you did to remove the copyright frame from the First master 
page) and move the top of the music frames down a little to increase the gap.

In any product version, you could also increase the top music frame margins; however, that 
applies to the first page as well, which has less vertical space due to the title and composer 
information.

Laying out and formatting pages
Starting on a left-hand page 

64
Dorico 3.5.12



● If you have Dorico Elements or Dorico SE, you could create a title page in another application 
then combine it into the exported PDF of the project so that the resulting document has 
three pages.

If you have Dorico Pro, instead of changing the initial page number, you could insert an 
empty page at the start of the layout and create a title page using text and graphics frames. 
We won’t cover that in this guide, but you can refer to video tutorials such as this one.

Changing stem directions
In order to help clarify which notes are played by the right and left hands, the stems of some 
notes point in a different direction to the default according to their pitch. To match this, you can 
change the stem direction of individual notes.

PROCEDURE

1. In bars 30, 31, 72, and 73, Ctrl/Cmd -click the Cs.

● You can zoom in to make notes appear larger by, for example, pressing Ctrl/Cmd-= or 
Z  or using the zoom options  in the status bar at the bottom of the 
project window.

2. Press F  to flip the stem direction of the selected notes.

● Because the stems of notes on the middle staff line can point upwards or downwards 
depending on the surrounding context, Dorico also flips the stem of the B♭s in bars 30 
and 72 now the Cs in those bars have up stems. However, the B♭s should have down 
stems to differentiate between the hands.

3. Select the B♭s in bars 30 and 72 and press F .

RESULT
The stems of the selected notes are flipped: the Cs now point upwards and the B♭s downwards.
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NOTE

We don’t recommend flipping the direction of stems when instead you should change notes to 
an up-stem or down-stem voice. Where rests aren’t shown, Dorico automatically changes the 
stem direction of notes according to their pitch regardless of their voice.

Changing beam grouping
Dorico automatically beams notes according to the prevailing meter (time signature). The 
original edition of this piece has some beam groups that don’t follow the meter, so you must 
change the beam grouping manually.

PROCEDURE

1. In bars 5, 7, 21, 23, 47, 49, 63, and 65, Ctrl/Cmd -click the Fs on the top staff.

2. Choose Edit > Beaming > Make Unbeamed, or right-click and choose this option from the 
context menu, to separate all selected notes from their beam groups.

3. In bars 14-17 and 56-59, Ctrl/Cmd -click the third eighth note in each bar on the top staff.

4. Choose Edit > Beaming > Split Beam, or right-click and choose this option from the context 
menu, to split beams to the left of the selected notes but leave them beamed on their other 
side.

5. In bars 33-35, select the first 32nd note Fs in each bar, that is, the fourth note in each bar.
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6. Choose Edit > Beaming > Split Beam, or right-click and choose this option from the context 
menu, to split beams to the left of the selected notes.

RESULT
You have changed the default beam grouping in the selected bars.

TIP

If the beam grouping changes you want are consistent across many bars, you can specify them 
as part of the time signature, such as by entering [2+3+2]/8 into the popover for a 7/8 time 
signature grouped in 2+3+2. In Dorico Pro, you can also change the default beam grouping in 
different circumstances on the Beam Grouping page in Notation Options (key command Ctrl/
Cmd-Shift-N ).

Aligning dynamics
If you added dynamics separately, you might notice they aren’t aligned vertically. You can group 
dynamics together so they align in a row.

PREREQUISITE
You are in Write mode (press Ctrl/Cmd-2 ).

PROCEDURE

1. In Write mode, select the dynamics you want to group together in a single group. For 
example, we added all the hairpins in bars 37-40 separately so they aren’t aligned.
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2. Choose Edit > Dynamics > Group Dynamics, or right-click and choose this option from the 
context menu.

RESULT
The selected dynamics are grouped together and automatically align. When you select any 
dynamic in a group, the other dynamics in the group appear highlighted.

Grouped dynamics function as a single unit, so for example, lengthening/shortening commands 
now apply to the group as a whole rather than individual dynamics within it.

TIP

● In Dorico Pro, you can also graphically align dynamics in a row without grouping them. You 
can do this in Engrave mode by selecting dynamics and choosing Edit > Dynamics > Align 
Dynamics, which can only apply in individual layouts whereas grouping dynamics applies to 
all layouts.

● You can also link dynamics vertically, which connects the same dynamics across multiple 
staves.

AFTER COMPLETING THIS TASK
Continue grouping other dynamics together that you want to align and have in the same group. 
For example, in bars 51-52 and 53-54.

Adjusting the shapes of slurs (Dorico Pro only)
A number of slurs follow their default curvature direction and shape according to the voices they 
were added to, whereas in the original edition they cover whole phrases, including starting from 
rests. Because slurs can’t start or end on rests in Dorico, you must adjust their shapes manually 
to achieve this effect.

NOTE

Although you can change the curvature direction of slurs in all product versions, any further 
adjustments are only possible in Dorico Pro. Therefore we do not recommend these steps for 
Dorico Elements or Dorico SE users.

PROCEDURE

1. In bars 9-12, Ctrl/Cmd -click the slurs on the top staff.
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2. Press F  to change their curvature direction so they curve upwards.

3. If you are not already in Engrave mode, press Ctrl/Cmd-3  to switch to Engrave mode.

4. Select the start handle of the flipped slurs.

● You can show handles on all items, not just selected items, by choosing Engrave > Show 
Handles > Always. This can make it easier to select individual handles on multiple items.

5. Press Ctrl/Cmd-Alt/Opt-Up Arrow  until the endpoints are positioned above the quarter 
note (crotchet) rest.

● We recommend pressing Ctrl/Cmd-Alt/Opt-Up Arrow  four times.

6. Select the control points one at a time and move them until the slurs curve around the beam.

● The control points are the inner pair, that is, the second and fourth handles.
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● The poco rit. does not automatically move out of the way of the slur as this is arguably a 
creative choice of slur placement. You can select the poco rit. and A tempo markings and 
press Ctrl/Cmd-Alt/Opt-Up Arrow  to move them graphically upwards.

RESULT
You have changed the curvature direction and shape of the slurs, and optionally moved the 
tempo marks in bars 11-12 out of the way of the slur’s new position.

AFTER COMPLETING THIS TASK
Repeat these steps for other similar slurs in bars 13-14 and 51-56.

Moving items graphically (Dorico Pro only)
As a final step, you can tweak the exact graphic positions of items in Engrave mode in Dorico Pro. 
In this task, you will improve the positions of left and right hand indications, change the angles 
of some hairpins, and move another hairpin to allow the top and bottom staves to be closer 
together.

PREREQUISITE
You are in Engrave mode (press Ctrl/Cmd-3 ).

PROCEDURE

1. In bars 72-73, select the “l.H.” text objects below the top staff.

2. In the Properties panel at the bottom of the window, activate Avoid collisions but leave the 
checkbox deactivated.

● If the Properties panel isn’t shown, press Ctrl/Cmd-8  to show it.

● When the property is activated but the checkbox is deactivated, the selected text objects 
do not automatically avoid collisions or contribute towards Dorico’s vertical spacing 
calculations. When the property is deactivated, text objects follow the default setting for 
text collision avoidance (Dorico Pro users can change this on the Text page in Engrave > 
Engraving Options).

3. In bars 39-40, select the final hairpin in the group.
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4. Press Ctrl/Cmd-Alt/Opt-Up Arrow  once to move the hairpin upwards.

● The bottom staff automatically moves upwards slightly with the reduced pressure on 
vertical spacing.

5. In bars 33-35, select the end handle on each hairpin (the middle handles at the end).

● You can show handles on all items, not just selected items, by choosing Engrave > Show 
Handles > Always. This can make it easier to select individual handles on multiple items.

6. Press Ctrl/Cmd-Alt/Opt-Up Arrow  five times.

7. Select the start handles on each hairpin (the middle handles at the start).

8. Press Ctrl/Cmd-Alt/Opt-Right Arrow  twice, then Alt/Opt-Up Arrow  twice.

● Alt/Opt  plus arrow keys moves items graphically a small amount. Adding Ctrl/Cmd  as 
well moves items graphically by a larger amount.
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RESULT
You have deactivated collision avoidance for the “l.H.” text objects, allowing them to be 
positioned between the staff and the hairpin, and moved both whole hairpins and individual 
hairpin handles to change their angles.

To provide a stable result, most graphical edits in Engrave mode do not affect the positions of 
other items.

AFTER COMPLETING THIS TASK
There’s always more detail that you could look at when engraving, but for now we think this 
piece looks good.

In the next set of steps, you can play the piece back to hear the results of your work and make a 
few adjustments to how it sounds in playback without affecting its notation.
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Playing back music

The next step in the process is listening to how the music sounds in playback and making 
changes if required. There are many different ways you can adjust how your music sounds in 
playback; the following tasks cover a few simple adjustments.

Although you can start and stop playback in any mode, most playback-related work happens in 
Play mode.

In Play mode, the area in the middle of the project window that was previously the music area, 
showing staves on pages, becomes the event display with music appearing in tracks and notes 
represented on piano rolls. At the top of the event display, there is a ruler showing bar numbers 
and beat divisions according to the current rhythmic grid resolution, which you can change using 
the rhythmic grid selector  in the status bar at the bottom of the window.

The playhead (the green vertical line) is always visible in Play mode, not only during playback.

NOTE

The flow menu in the top left of the event display uses flow names set in the Flows panel in 
Setup mode, not the flow title set in Project Info.

Changing the audio output device
Before you start playing back music, it’s worth checking that your audio output device is correctly 
set up so you can hear your music.

PREREQUISITE
If you connected an external device you want to use for audio output after starting Dorico, you 
must restart Dorico.

PROCEDURE

1. Press Ctrl/Cmd-,  to open Preferences.

2. Click Play in the category list.

3. In the Audio Device subsection at the bottom, click Audio Device Setup to open the Device 
Setup dialog.

4. Select the audio output device you want to use from the ASIO Driver menu.
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5. If you want to edit settings for the device, click Device Control Panel to open the settings 
dialog.

● Windows users: To allow sound from other applications alongside Dorico, such as online 
videos, deactivate Allow ASIO host application to take exclusive control of selected 
port configuration.

● macOS users: If you don’t want Dorico to set the audio output volume to maximum 
automatically, deactivate Set Device Attenuation To 0 dB. To allow Dorico to switch 
between computer output and headphones automatically, activate Automatically 
Configure Devices.

6. Click Close for each dialog.

RESULT
Your audio device output is changed, including optionally its device settings.

Applying a playback template
Dorico uses playback templates to load all the required sounds for the instruments in your 
project. If you have installed the sounds provided with your Dorico version, you can apply the 
corresponding playback template.

PREREQUISITE

● You are in Play mode (press Ctrl/Cmd-4 ).

● You have downloaded and installed the sounds provided with your Dorico version. You do 
not have to install them to run Dorico, but because they come with playback templates and 
expression maps set up, they are often the simplest way to hear your music played back.

PROCEDURE

1. Choose Play > Playback Template to open the Apply Playback Template dialog.

2. Select the playback template for your product version.

● If you have Dorico Pro, select HSSE+HSO (Pro).

● If you have Dorico Elements, select HSSE (Elements).

● If you have Dorico SE, select HSSE (SE).

3. Click Apply and Close.
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RESULT
The selected playback template is applied to the project. If it was already applied, it is re-applied, 
resetting the playback template back to its defaults.

In the VST and MIDI Instruments panel on the right of the window, a plug-in instance is loaded 
with sounds for the piano.

If you want to open the VST instrument window, click Edit Instrument .

Playing back the piece
With piano sounds loaded, you can now listen to the whole piece played back. You can do this in 
any mode.

PROCEDURE

● Press Shift-Alt/Opt-Space  to start playback from the beginning.

● If the playhead was not already at the beginning of the flow, it jumps there and moves 
along with the playback.

● You can also start playback from the current position of the playhead by pressing Space 
or Enter , or from a selected item by pressing P . Selecting multiple different items on 
specific staves and pressing P  only plays back those staves.

RESULT
Playback starts from the beginning of the flow and stops at the end, allowing you to listen to the 
whole piece. If you had other flows in the project, playback would continue to the next flow after 
a short gap between them.

TIP

If you have problems hearing sounds, check this troubleshooting video. Windows users: in 
order to watch the video, make sure your audio output device settings allow sounds from other 
applications; alternatively, quit Dorico before watching the video.

Playing back music
Playing back the piece 

75
Dorico 3.5.12

https://youtu.be/5BcPJd92zqU


AFTER COMPLETING THIS TASK
If you want to change the overall tempo, switch back to Write mode (press Ctrl/Cmd-2 ), select 
the Grazioso tempo mark at the start, and change the value for Tempo (bpm) in the Tempo 
group of the Properties panel.

RELATED LINKS
Changing the audio output device on page 73

Changing dynamic levels in playback
You can change the levels of dynamics in Play mode without affecting their appearance in 
the music. To demonstrate this, these steps focus on bars 21-30, adjusting the volume of the 
consecutive crescendo hairpins and adding a subtle unmarked diminuendo leading into bar 30 to 
shape the phrase.

PREREQUISITE
If you want to reduce the gap between the piano roll editor and the ruler, you can hide the Time 
and Chords tracks at the top of the event display by choosing Play > Tracks and clicking each 
one so they are unticked.

PROCEDURE

1. Click the arrow in the piano track header to expand the track.

2. In the piano track header, click Show the dynamics lane  to show the dynamics lane 
below the track.

● To make tracks and lanes taller or shorter, click and drag in the bottom left corner of the 
track header where the mouse pointer appears as a split arrow. You can also select track 
headers and press Shift-H  to make those tracks taller or Shift-G  to make them shorter.

● There is a cumulative volume increase across the three crescendo hairpins in bars 21-26. 
However, they most likely indicate shaping that resets at the start of each phrase, so you 
can adjust their start dynamic levels.

3. If Object Selection is not already selected, press S  to select it.

● You can also click Object Selection  in the Play toolbox on the left of the window.

4. In bar 23, click and drag the crescendo start handle downwards until the readout displays -1, 
that is, until it is at a similar level to the start of the crescendo in bar 21.
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5. Click and drag the crescendo end handle downwards until the readout displays 0.

● You could also do the same for the next crescendo in bar 25, but the current phrasing 
with the third crescendo sounding a bit louder feels quite natural. When you release the 
mouse after lowering the crescendo end in bar 24, the crescendo in bar 25 also lowers 
accordingly.

6. Press D  to select the Draw tool.

● You can also click Draw  in the Play toolbox on the left of the window.

7. In bar 22, click on beat 3 at a similar level to the start of the previous and next crescendos to 
input a dynamic point.

● This means the downbeat in bar 23 plays back at the lower dynamic level, which sounds 
more natural.
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● The next steps involve the velocity lane, so you can hide the dynamics lane by clicking 
Show the dynamics lane  again.

8. Click Show the MIDI note velocity editor  to show the velocity lane.

● Velocity controls the dynamics of non-sustaining instruments, including the piano.

9. Press L  to select the Line tool.

● You can also click Line  in the Play toolbox on the left of the window.

10. Click and drag a downwards-sloping line from bar 27, beat 2, to just before the start of bar 
30, following the suggested incline in bar 26.

● When you release the mouse, all the note velocities within the affected range are 
adjusted. They are shown with a different color to indicate they have been changed.

11. If you want to adjust the velocity of individual notes to humanize the phrase again, press S 
to reselect Object Selection, and then click and drag up or down on individual velocity bars 
to produce a less uniform result.

● To change the velocity of individual notes in chords, first select the note in the piano roll, 
then change the velocity.

RESULT
You have changed the dynamic levels in a single phrase without affecting the notated music.
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AFTER COMPLETING THIS TASK

● To listen to just the affected bars to check the result, you can click in the ruler at the top of 
the event display to move the playhead to that position and press Space or Enter  to start or 
stop playback from that position.

● You can continue changing dynamic levels elsewhere if you like.

Changing the poco rit. final tempo
The poco rit. in bars 42-43 sounds like it needs a little more time. To achieve that, you can reduce 
its final tempo.

PROCEDURE

1. If you hid the Time track, choose Play > Tracks > Time Track to show it.

2. Click the arrow in the Time track header to expand the track.

3. If Object Selection is not selected, press S  to select it.

4. At the start of bar 43, click and drag the rit. end handle downwards until the readout displays 
40.

RESULT
The final tempo of the poco rit. is changed.

TIP

You can also change the final tempo of gradual tempo changes in Write mode by using the 
Final tempo % property in the Tempo group of the Properties panel. When you change the 
final tempo of gradual tempo changes in the Time track, Dorico calculates the corresponding 
percentage change.

AFTER COMPLETING THIS TASK
Click in the ruler at the top of the event display anywhere in bar 41 to move the playhead there, 
then press Space or Enter  to start playback and hear the effect this has on the tempo.

Changing the played duration of notes
After reducing the final tempo of the poco rit. in the previous task, it sounds like the played 
(sounding) duration of the last chord in bar 42 should be adjusted for a smoother transition 
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back into the starting material. You can change the played duration of notes in Dorico without 
affecting their notated duration.

These adjustments are subjective, but we suggest making the quarter note (crochet) sound a 
little shorter and the eighth notes (quavers) sound a little longer to create the effect of a breath 
before the start of bar 43.

PREREQUISITE
Make sure that Played Durations  and Object Selection  are selected in the Play toolbox on 
the left of the window.

PROCEDURE

1. In the ruler at the top of the event display, click and drag downwards to make notes in the 
piano roll wider.

● This makes it easier to make small adjustments. You can also use the key command 
Ctrl/Cmd-= or Z .

● When you click in the ruler, the playhead jumps to the position of your mouse pointer.

2. In bar 42, click and drag the right end of the E♭ quarter note event on beat 3 to the left a little 
to shorten its sounding duration.

3. Click and drag the right end of the other note events on beat 3 to the right a little to 
lengthen their sounding duration.

● They don’t have to line up; in fact, having them end at slightly different times creates a 
more natural effect.
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● Overriding the default played durations removes the start offsets on the arpeggiated 
notes so you need to delay their starts.

4. Click and drag the left end of the B♭ and G on the bottom staff to the right a little, with the G 
starting later than the B♭.

RESULT
You have overridden the default played durations of some note events without changing how 
those notes are notated in the score. They are shown with a different color in the piano roll to 
indicate they have been changed.

AFTER COMPLETING THIS TASK

● Click in the ruler at the top of the event display anywhere in bar 41 to move the playhead 
there, then press Space or Enter  to start playback and hear how this sounds.

● If you want, you can continue tweaking the played durations of notes, dynamics, and/or 
tempo fluctuations throughout the piece.

NOTE

Moving the start/end positions of dynamics and tempo marks in Play mode, such as making 
a rit. start on beat 1 rather than beat 2, affects where those items appear in the music. This 
also applies to moving or lengthening/shortening note events with Notated Durations 
selected in the Play toolbox.
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Printing and exporting

Once you are happy with how the piece looks on the page and sounds in playback, you can print 
and export it in a variety of formats, including graphics and audio files. The following tasks cover 
a few common printing and exporting operations.

In Print mode, the area in the middle of the project window becomes the print preview area. The 
panel on the right is the Print Options panel, where you can find all the printing and exporting 
options. You can set different options for different layouts and then print and/or export them all 
together with those settings retained.

NOTE

In projects with multiple layouts, the layout shown as a print preview is the one selected in the 
Layouts list on the left of the window, not from the layout selector in the toolbar at the top.

Printing hard copies
If you have a printer connected to your computer, you can print hard copies of layouts directly 
from Dorico. If you don’t have a printer or don’t want to print a hard copy, you can skip this task.

PREREQUISITE
You are in Print mode (press Ctrl/Cmd-5 ).

PROCEDURE

1. In the Print Options panel on the right, choose Printer in the Destination section at the top.

2. Select the printer you want to use from the menu.

3. Enter the number of hard copies you want to print into the Copies field.

4. If you entered 2 or more, activate/deactivate Collate copies.
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5. In the Job Type section, select the appropriate print arrangement from the menu.

● If your printer can only print A4, select Normal.

● If your printer can print A3 and you have not added a title page, select 2-up.

● If your printer can print A3 and you have added a title page, select Booklet.

6. If you selected Normal or 2-up, choose All Pages.

7. In the Page Setup section, choose the options appropriate for your printer and job type.

● For the Normal job type: select A4 paper, Portrait  orientation, and Fit to Paper.

● For 2-up and Booklet job types: select A3 paper, Landscape  orientation, and Fit to 
Paper.

8. For Booklet jobs only: In the Duplex Printing section, choose the options appropriate for 
your printer.

● Both sides automatically is only available for printers that support automatic 
duplexing.

● You can refer to the Operation Manual for more information about the duplex printing 
options.

9. When you are happy with your settings, click Print at the bottom of the panel.

TIP

To show a preview of the full page in the print preview area, click Whole Page in the bottom 
right of the project window.

RESULT
The full score layout is printed according to your options.

Exporting to PDF
You can export any layout as PDF, PNG, SVG, and TIFF graphics files. Because the most common 
and useful format for musical scores is arguably PDF, this task covers exporting to PDF with a 
watermark to indicate it’s a proof.

PREREQUISITE
You are in Print mode (press Ctrl/Cmd-5 ).

PROCEDURE

1. In the Print Options panel on the right, choose Graphics in the Destination section at the 
top.

2. Select PDF from the menu.

3. Choose Color.

● As you will add a watermark to this layout, you need Color to show this. You would also 
need Color if you have items with changed colors or opacity in a layout.

Apart from the watermark, the difference between Mono and Color would be minimal 
for this layout. Some printers print black differently when the document is color versus 
mono.

● Layouts exported as Color graphics have transparent backgrounds.

● The Resolution setting does not affect PDF and SVG files as they are vector formats.

Printing and exporting
Exporting to PDF 
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4. Click Choose Folder  beside the Destination folder field to open the File Explorer/macOS 
Finder.

5. Locate and select the destination folder you want.

6. Click Select Folder (Windows)/Open (macOS) to insert the new path in the Destination 
folder field.

7. If you want to change the file name recipe (the naming structure used for the exported PDF), 
click File Name Options to open the Export File Names dialog and change the file name 
recipe for PDF files.

NOTE

Changing the file name recipe also affects all future projects you open on your computer.

8. Make sure that the rest of the settings in the Print Options panel are correct to export with 
separate portrait pages, which they should be by default.

● In the Job Type section, select Normal and All Pages.

● In the Page Setup section, choose Portrait .

9. In the Annotations section, activate Watermark and enter PROOF into the value field.

TIP

If you have Dorico Pro and want longer watermark text, you can reduce the Print 
Watermark Font font size in Engrave > Font Styles.

10. Click Export.

RESULT
The full score layout is exported as a PDF with your settings and the “PROOF” watermark.

Printing and exporting
Exporting to PDF 
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Exporting the audio
You can export the audio of projects as MP3 or WAV audio files, for example, to share how a 
piece sounds with someone who does not have Dorico.

PROCEDURE

1. In any mode, choose File > Export > Audio to open the Export Audio dialog.

2. At the top of the dialog, choose Export Compressed MP3 (.mp3).

● As part of these steps, we suggest exporting as MP3 because the resulting MP3 file size 
is much smaller than WAV files.

3. Deactivate Export each selected flow as a separate file.

● If this option were activated, the resulting MP3 file would be inside an additional folder 
named after the flow. In a single-flow and single-player project like this one, the options 
for exporting flows and players as separate files make no significant difference, but 
would be useful if you wanted to export stems of individual players separately for each 
flow, for example.

4. At the bottom of the dialog, click Choose Folder  to open the File Explorer/macOS Finder.

5. Locate and select the destination folder you want.

6. Click Select Folder (Windows)/Open (macOS) to insert the new path in the Export to field.

7. Click OK to export the audio as an MP3 file and close the dialog.

RESULT
The project is exported as an MP3 audio file in a folder inside the selected destination folder.

Printing and exporting
Exporting the audio 
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Further notations

Congratulations! You have completed the Dora Pejačević “Walzer-Capricen No. 2” piano piece 
project. We hope you enjoyed the process and learned useful Dorico operations along the way.

In the following tasks, you will build on the inputting techniques you’ve already learned and 
extend them to other common notations, including lyrics, chord symbols, and rhythm slashes. 
You will also input notes for a drum set, show chord symbols above specific staves, enable swing 
playback for only one player, and remove a player from the full score but keep them in the 
project.

The song used in these tasks is Gertrude “Ma” Rainey’s “See See Rider Blues”. A PDF of the 
excerpt used in these tasks is available on steinberg.help, along with a Dorico project set up as a 
starting point for the following tasks.

NOTE

As the project contains more than two players, it opens in read-only mode in Dorico SE. Dorico SE 
users must instead set up separate Dorico projects, each with up to two players, for these tasks.

Adding lyrics
Perhaps unsurprisingly at this stage, Dorico has a dedicated popover for inputting lyrics that 
stays open after each lyric/syllable. You can press different keys to advance the popover to the 
next note automatically depending on whether the lyric/syllable needs a hyphen after it or not.

PREREQUISITE

● You have input the vocal melody. Although you can input lyrics independently of notes, it is 
much easier to input lyrics with notes already there.

● You are in Write mode (press Ctrl/Cmd-2 ).

PROCEDURE

1. In Write mode, select the first note on the vocal staff, that is, the C in bar 5.

● You can do this in the full score or the voice part layout.

2. Press Shift-L  to open the lyrics popover.

3. Enter the first syllable I’m into the popover.

4. Press Space  to advance the popover to the next note.
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● Pressing Space  tells Dorico the lyric you input was a complete word, or the final syllable 
in a multi-syllabic word.

5. Enter so into the popover, then press Space .

● The next word comprises three syllables, so you must advance the popover differently.

6. Enter un into the popover, then press - .

● The hyphen between syllables does not appear until you input the next syllable.

7. Enter hap into the popover, then press - .

8. For the final syllable, enter py, into the popover, then press Space .

9. In bar 6, enter the lyrics I feel so blue, into the popover.

10. In bar 7, enter the lyrics I al-ways feel so sad, into the popover.

● You might notice that ways and sad, are left-aligned with their noteheads rather than 
center-aligned because they span more than one notehead, and that after you input 
sad, Dorico lowers the whole line to avoid a collision with the A.

● Dorico counts tied notes as a single note.

11. Continue inputting the lyrics up to the end of bar 11.

I made a mis-take, right from the start, Oh, it seems so hard to

● The next syllable is sung over two notes.

12. In bar 12, enter part into the popover, then press Space  twice.

● This advances the lyrics popover two notes ahead. When you press Space  the second 
time, Dorico recalculates the horizontal alignment of the lyric: it is now left-aligned with 
the notehead rather than center-aligned.

Further notations
Adding lyrics 
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13. Continue inputting the lyrics until the end of bar 26.

A-bout this let-ter, that I will write, I hope he will re-mem-ber, when he re-ceives it, 
See, see, ri-der, see what you done done, Lawd, lawd, lawd, You made me love you, now 
your gal done come. You made me love you, now your gal done come.

● The lyrics lawd, on beat 3 in bar 20 and come. at the end of bar 22 require two Space 
presses. All other lyrics only require a single Space  press.

RESULT
You have input the lyrics for the first verse and chorus. Dorico automatically shows lyric hyphens 
between syllables and lyric extender lines for lyrics on tied notes or that span multiple notes 
when there is sufficient horizontal space. Dorico also automatically left-aligns lyrics that span 
more than one note, including tied notes, and calculates a consistent vertical position for whole 
lyric lines in each system.

TIP

● If you have the lyrics written out with syllables separated appropriately using hyphens 
already, such as in a text editor or existing lines of lyrics in Dorico, you can copy and paste 
them into the lyrics popover. When the lyrics popover is open and the lyrics are copied to 
your clipboard, you can simply press Ctrl/Cmd-V  to input each syllable one at a time. For 
syllables that span more than one note, you must press -  or Space  to tell Dorico how long 
they should last.

● You can change the alignment of individual lyrics by selecting them and using the Lyric text 
alignment property in the Lyrics group of the Properties panel. In some cases, this can 
reduce how much notes are moved horizontally to accommodate lyrics.

Adding fermatas
There is a pause in the recording of this song in the beats before the first chorus. One way of 
notating this is to use a fermata, also known as a pause mark.

PROCEDURE

1. In bar 16, select the G on beat 3 on the vocal staff.

2. Press Shift-H  to open the holds and pauses popover.

3. Enter fer into the popover.

4. Press Return  to close the popover and input a fermata at the selected rhythmic position.

5. Select the C on beat 4 and repeat steps 2 to 4.

Further notations
Adding fermatas 
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RESULT
You have input two fermatas on the last two beats in bar 16. Dorico automatically shows 
fermatas on all staves, including adjusting the note or rest they appear on according to the 
contents of each staff.

Selecting a fermata on one staff selects it on all staves, because they are all representations of 
the same, single item. On the bottom piano staff and trombone and banjo staves, it appears 
above the closest note to its rhythmic position, in this case the whole note or bar rest, but there 
are attachment lines indicating its actual position on each staff.

NOTE

● Fermatas do not currently affect playback.

● You can also add fermatas using the Holds and Pauses panel on the right of the window, 
which you can show by clicking Holds and Pauses  in the Notations toolbox.

Adding a mute playing technique
To indicate that the cornet player should use a mute, and to use a muted cornet sound in 
playback, you can input a con sordino playing technique.

PROCEDURE

1. In bar 1, select the first note on the cornet staff.

2. Press Shift-P  to open the playing techniques popover.

Further notations
Adding a mute playing technique 
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3. Enter con s into the popover.

● Because the playing techniques popover requires exact popover entries in order to 
create specific playing techniques, a menu with valid playing techniques appears when 
you start entering into the popover.

4. Press Down Arrow  to select con sord.

5. Press Return  to close the popover.

RESULT
A con sordino playing technique is input. It has an associated “Muted” playback technique. Dorico 
uses playback techniques to link playing technique notations with techniques or articulations in 
sound libraries in order to produce the correct sounds in playback.

Like other notations, playing techniques are automatically aligned relative to their rhythmic 
position. Text playing techniques are left-aligned, whereas glyph playing techniques are center-
aligned. Dorico also performs automatic collision avoidance, meaning the tempo mark moves 
upwards to accommodate the playing technique.

Adding chord symbols
The input method for chord symbols is similar to lyrics in that you can advance the chord 
symbols popover after inputting each chord symbol without closing it, allowing you to input 
sequences of chord symbols in one go.

An important aspect of chord symbols in Dorico is that they exist globally by default, meaning 
you can input a chord symbol once but show the same chord symbol for all players in the 
ensemble if needed. You can also input local chord symbols if one player needs a different chord.

PROCEDURE

1. In bar 1, select the bar rest on the banjo staff.

NOTE

You could input chord symbols on any staff and hide them for that player later. However, for 
simplicity, we recommend inputting chord symbols onto staves that you want to show chord 
symbols on anyway.

Further notations
Adding chord symbols 

90
Dorico 3.5.12



2. Press Shift-Q  to open the chord symbols popover.

3. Enter C7 into the popover.

4. Press Space  four times to advance the popover to the start of bar 2.

● Each time you press Space , the chord symbols popover advances one beat according to 
the current time signature, which is one quarter note (crotchet) in this song’s 4/4 time 
signature.

5. Enter G7/D into the popover, then press Space  twice.

6. Enter C7 into the popover, then press Space  twice.

7. Enter F into the popover, then press Space  twice.

8. Input the remaining chord symbols in bars 3-4, pressing Space  once between them.

G#dim7, Gm7, F, C7, then F.

RESULT
You have input the chord symbols in the first four bars of the song. They automatically appear 
above rhythm section instrument staves, which in this project are the banjo and piano.

NOTE

Some chord symbols might look different when input compared to what you entered into the 
popover, such as if you input the Fdim7 in bar 5 as Fdim. Dorico uses default settings to 
determine the appearance of chord symbols based on their type rather than your popover entry. 
If you have Dorico Pro, you can change these settings on the Chord Symbols page in Engrave > 
Engraving Options.

Further notations
Adding chord symbols 
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AFTER COMPLETING THIS TASK

● Continue inputting chord symbols for the rest of this excerpt, remembering that Return 
closes the popover and Space  advances it by one quarter note for each press.

● Some chord symbols collide with barlines, such as the Fdim7 in bar 5. You can change the 
alignment of these chord symbols to avoid the collision by selecting them, activating the 
Alignment property in the Chord Symbols group of the Properties panel, and selecting 
Center from the menu.

Adding rhythm slashes
As this blues song involves lots of improvisation, you can use slash regions to fill bars with 
rhythm slashes to indicate those players should improvise.

PROCEDURE

1. In bar 1, select the bar rest on the trombone staff.

● We recommend doing this in the full score, where by default empty bars are not 
consolidated into multi-bar rests.

2. Shift -click the bar rest in bar 4 on the trombone staff.

3. Press Shift-R  to open the repeats popover.

4. Enter slash into the popover.

5. Press Return  to close the popover and input a slash region spanning the selection.

● Dorico automatically displays the appropriate number of slashes for the duration and 
the current time signature. For example, if this were in 6/8, Dorico would show two 
dotted slashes in each bar.

6. Repeat steps 1 to 5 for the banjo and top piano staff.

TIP

Alternatively, you can select the slash region on the trombone staff and Alt/Opt -click the 
start of bar 1 on the banjo staff and top piano staff.

Further notations
Adding rhythm slashes 
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● However, in the recording, only the clarinet plays on beat 4 in bar 4.

7. Select any part of the slash regions in bars 1-4 on the trombone, banjo, and piano staves.

8. Press Shift-Alt/Opt-Left Arrow  to shorten the slash regions back to the end of beat 3.

● The number of presses required depends on your rhythmic grid resolution .

9. In bar 5, select the bar rest on the trombone staff.

10. Shift -click or Ctrl/Cmd -click the bar rest in bar 16 on the trombone staff.

11. Input a slash region.

● If these regions were adjacent, the second would have a different highlight color to 
distinguish them.

12. Repeat steps 9 to 11 for the banjo.

13. Input slash regions on the cornet staff in bars 5-7 and bar 9 (beat 2) to bar 12.

Further notations
Adding rhythm slashes 
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● You should now have rhythm slashes throughout bars 1-16 for the cornet, trombone, 
and banjo. However, the fermatas in bar 16 do not appear automatically in slash 
regions.

14. Select any part of the slash regions in bars 5-16 on both the trombone and banjo staves.

15. Press Shift-Alt/Opt-Left Arrow  to shorten the slash regions back to the end of beat 2.

● The number of presses required depends on your rhythmic grid resolution .

16. In bar 16, double-click the trombone staff on beat 3, that is, just after where the slash region 
ends.

17. Press Shift-Alt/Opt-V  until the caret indicator shows a stemless slash voice.

18. Press 6  to select quarter notes (crotchets).

19. Press Y  twice to input two quarter note stemless slash notes.

20. Press Left Arrow  until the caret is at the start of beat 3 in bar 16, then press Down Arrow 
to move the caret down to the banjo staff.

21. Repeat steps 17 to 19.

22. Press Esc  or Return  to stop note input.

Further notations
Adding rhythm slashes 
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RESULT
You have input slash regions and input notes into stemless slash voices. Using a combination of 
slash regions and slash voices can be useful, for example, if some bars have particular rhythms 
you want to specify using rhythm slashes.

TIP

You can also add slash regions from the Repeat Structures panel on the right of the window, 
which you can show by clicking Repeat Structures  in the Notations toolbox.

Adding bar repeats
In addition to rhythm slashes to indicate improvisation, you can use bar repeats as a short-hand 
to tell players to repeat what they did in the previous bar.

PROCEDURE

1. In bar 6, select the bar rest on the top piano staff.

2. Press Shift-R  to open the repeats popover.

3. Enter % into the popover.

4. Press Return  to close the popover and input a bar repeat region spanning the selection.

● Keep the bar repeat region selected.

5. Alt/Opt -click the bottom piano staff at the start of bar 6 to copy the bar repeat region at 
that position.

Further notations
Adding bar repeats 
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6. Repeat steps 1 to 5 for bars 10 and 14.

RESULT
You have input bar repeat regions for single bars on both piano staves.

TIP

You can also add bar repeat regions from the Repeat Structures panel on the right of the 
window, which you can show by clicking Repeat Structures  in the Notations toolbox.

Showing chord symbols above different staves
Chord symbols automatically appear above rhythm section instrument staves. However, in this 
song it is useful to show chord symbols for other instruments too to help their improvisation.

PREREQUISITE
You are in Setup mode (press Ctrl/Cmd-1 ).

PROCEDURE

1. In the Players panel on the left, select the Trombone player.

2. Right-click the player card and choose Chord Symbols > Show in Chord Symbol and Slash 
Regions from the context menu.

3. Repeat step 2 for the clarinet and cornet players.

RESULT
You have set chord symbols to show in chord symbol or slash regions for the clarinet, cornet, and 
trombone. They were already set to show throughout the project for the banjo and piano.

Further notations
Showing chord symbols above different staves 
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TIP

You can also use this context menu to change which layouts chord symbols appear in.

Adding a drum set
This song did not originally include any percussion, but in order to demonstrate how Dorico 
handles percussion kits including drum sets, in this task you will add a hypothetical drum set to 
the project.

PREREQUISITE
You are in Setup mode (press Ctrl/Cmd-1 ).

PROCEDURE

1. Press Shift-P  to add a new solo player and open the instrument picker.

● You can also click Add Solo Player  at the bottom of the Players panel.

2. Enter drum into the instrument picker search box.

3. Make sure Drum Set (Basic) is selected, then click Add or press Return .

● New players are added below all other players. However, to follow both score order 
conventions and a common preference of keyboard players to have the piano at the 

Further notations
Adding a drum set 
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bottom of the ensemble when they read from the score, you need to move the drum set 
above the piano.

4. Click and drag the drum set player until the insertion line is above the piano.

5. Release the mouse to move the drum set player to the position of the insertion line.

● Because bracket grouping is set to Small ensemble for the full score, the drum set is 
now included in a bracket with the other instruments. However, it is preferable to make 
a distinction between pitched and unpitched instruments in the score.

TIP

You can change bracket grouping for each layout on the Brackets and Braces page in 
Setup > Layout Options (key command Ctrl/Cmd-Shift-L ).

6. With the drum set player selected, click Add Group  at the bottom of the Players panel.

RESULT
You have added a solo player, assigned a drum set to them, changed their position in the score, 
and put them in their own group to separate them from the other players’ bracket.

Further notations
Adding a drum set 
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TIP

The voice is in its own group for the same reason.

In Dorico, a percussion kit is a set of multiple unpitched percussion instruments that can be 
presented in different ways: each instrument on its own line, in a grid, or on a five-line staff. 
The same percussion kit can appear on a five-line staff in the full score but with single-line 
instruments in the part layout.

You can identify percussion kits by their green instrument labels in Setup mode.

TIP

● If you click the arrow  that appears in the instrument label when you hover over it and 
choose Edit Percussion Kit, you open the Edit Percussion Kit dialog where you can edit 
various aspects for each presentation independently, such as the voice for each instrument 
when using the five-line staff presentation.

● You can change the presentation type used in each layout in the Percussion section of the 
Players page in Setup > Layout Options.

Inputting notes on a drum set
Note input on percussion kits, which is what a drum set is in Dorico, works slightly differently 
than for other instruments. In this task, you will input a simple drum set part in keeping with the 
song’s style that demonstrates some useful percussion kit input techniques.

You might find this task easier in the drum set part layout rather than the full score. To switch 
layouts in the current tab, use the layout selector in the toolbar. To open the drum set part in a 
new tab, click New Tab  on the right of the tab bar and double-click Drum Set.

You can show separate empty bars rather than multi-bar rests in the drum set part layout on the 
Players page in Layout Options (key command Ctrl/Cmd-Shift-L ).

PREREQUISITE
You are in Write mode (press Ctrl/Cmd-2 ).

PROCEDURE

1. In bar 4, select the bar rest on the drum set staff.

Further notations
Inputting notes on a drum set 
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2. Press Shift-N  to start note input.

● On percussion kit staves, the caret appears shorter. The current instrument name is also 
shown in addition to the caret and the rhythmic grid.

3. Press Space  three times to advance the caret to beat 4.

4. Press Up Arrow  until the caret is on the hi-hat.

5. Press 5  to select eighth notes (quavers).

6. Press Y  until the end of beat 1 in bar 8.

● Y  is a generic note input key command that is particularly useful for percussion.

7. Press 6 , Y , 5 , Y , Y  again, 6 , then Y  once more.

8. Move the caret back to bar 4, beat 3.

● For example, you can press Ctrl/Cmd-Left Arrow  four times, then Left Arrow  twice, 
assuming your rhythmic grid resolution  is set to eighth notes (quavers).

9. Press Down Arrow  until the caret is on the snare drum.

● Currently this would input generic snare drum notes, but something subtler would be 
better for this song. Because unpitched percussion playing techniques are commonly 
notated with different noteheads, you can select unpitched percussion playing 
techniques during note input.

10. Press Alt/Opt-Up Arrow  to select the side stick playing technique.

Further notations
Inputting notes on a drum set 
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11. Make sure quarter notes (crotchets) are selected, then press Y .

● The default drum set in Dorico is already set up with the most common percussion 
playing technique noteheads, so the side stick snare drum note appears with a cross 
notehead.

● You could continue using the arrow keys to select other instruments in the kit and then 
pressing Y  to input notes for them, but when using the five-line staff presentation, you 
can also input notes as if they were on a pitched staff.

12. Press F  to input a kick drum note.

13. Press Space  twice to advance the caret two quarter notes.

14. Press C , then F  to input a snare drum note and kick drum note respectively.

● Dorico remembers the previous side stick playing technique selected for the snare drum 
and continues to use that.

● By default, five-line percussion kit staves are treated as if they had a treble clef, but you 
can change this to the bass clef on the Note Input and Editing page in Preferences 
(key command Ctrl/Cmd-, ).

15. Press Space  once, then Shift-Alt/Opt-D  to input a tom-tom note, then C , then F .

16. Press Space  twice, then C , then F .

17. Press Esc  or Return  to stop note input.

RESULT
You have input notes for different percussion instruments in the same drum set, including 
selecting a different playing technique for the snare drum.

AFTER COMPLETING THIS TASK
You could select bars 5-8 and press R  to repeat those four bars until the end of the excerpt, 
or instead you could use a bar repeat region indicating the player should repeat the four-bar 
phrase. The popover entry for that is %4 in the repeats popover ( Shift-R ).

Further notations
Inputting notes on a drum set 
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Adding tremolos
In bars 8 and 12 in the verse, the vocal part stops early in the bar. To fill in the space a little, you 
can add tremolos to the drum set part.

PROCEDURE

1. In bar 8, select the quarter notes (crotchets) on the drum set staff.

2. Press Shift-R  to open the repeats popover.

3. Enter /// into the popover.

4. Press Return  to close the popover.

RESULT
Three stroke single-stem tremolos are input on the selected notes.

TIP

You can also add tremolos using the Repeat Structures panel on the right of the window, which 
you can show by clicking Repeat Structures  in the Notations toolbox. Tremolos are included 
in the Repeat Structures panel because they indicate that notes should be repeated within the 
given duration.

Enabling swing playback for the drum set
The drum set part has lots of eighth notes (quavers) that could be played swung, as is idiomatic 
in blues song, but the other parts in this song are played straight. In Dorico, you can enable 
swing playback only for the drum set without affecting the other parts.

Dorico provides a number of swing ratios, categorized as “rhythmic feels”, by default.

PROCEDURE

1. In bar 1, select the bar rest on the drum set staff.

2. Press Shift-T  to open the tempo popover.

3. Enter swing into the popover.

Further notations
Adding tremolos 
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● Like for the playing techniques popover, a menu with valid rhythmic feels appears when 
you start entering into the popover.

4. Press Down Arrow  until you have selected 2:1 swing 8ths (fixed).

5. Press Alt/Opt-Return  to close the popover.

RESULT
Swing playback with the selected swing ratio is input for only the drum set part. It appears as a 
signpost above the drum set.

TIP

● Pressing Alt/Opt  in addition to Return  means the rhythmic feel only applies to the selected 
staff. Pressing Return  on its own enables swing playback for all players. You can also use 
Alt/Opt-Return  to close popovers (or Alt/Opt -click when using the corresponding panel) to 
input other voice- and staff-specific notations, such as time signatures and key signatures.

● You can hide/show some or all signposts from the View > Signposts menu.

● Rhythmic feels input using the tempo popover only affect playback in that flow. If you have 
Dorico Pro, you can also enable swing playback in the whole project on the Timing page in 
Play > Playback Options (key command Ctrl/Cmd-Shift-P ).

Removing the drum set from the full score
One of Dorico’s strengths is the flexible relationship between players, layouts, and flows. To 
demonstrate this, you can remove the drum set from the full score, because it was not in the 
original song, but keep the player and their music in the project for reference.

PREREQUISITE
You are in Setup mode (press Ctrl/Cmd-1 ).

Further notations
Removing the drum set from the full score 
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PROCEDURE

1. In the Players panel on the left, select the drum set player card.

2. In the Layouts panel on the right, deactivate the checkbox in the Full score layout card.

RESULT
The drum set player is removed from the full score layout. If you select the full score layout in the 
Layouts panel, all players apart from the drum set appear highlighted with activated checkboxes 
in the Players panel.

TIP

In Dorico, because you can have as many layouts with whatever combination of players you like, 
you could have two full score layouts: one with the drum set and one without.

Part layouts are automatically named after all the players assigned to them, and it is their layout 
name that appears in the top left of the first page in part layouts by default, not the player 
name. You can rename layouts by double-clicking their cards in the Layouts panel, for example, 
if you assigned multiple percussion players to one part layout and want it to be called simply 
“Percussion”.

Further notations
Removing the drum set from the full score 
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Final tips

We hope that you have enjoyed this guide and have learned some useful ways of working in 
Dorico. To finish, we would like to leave you with some final tips for maximizing your time and 
output, and to let you know where you can go from here.

● You can find comprehensive documentation on steinberg.help, including separate PDFs 
for popover entries and text tokens. There are quick reference cards for common key 
commands available on the Dorico blog and video tutorials on the Dorico YouTube channel. 
There is also a Dorico Resources page with both official and third-party resource links.

● Dorico Pro users: Check the available options Engrave > Engraving Options (key command 
Ctrl/Cmd-Shift-E ). There are many options for each notation, including default minimum 
gap settings, for example, if you want all playing techniques to appear further from the 
staff or all text objects to appear closer to the staff. Other options include changing the 
appearance of notations, such as whether gradual dynamics are hairpins or cresc. text by 
default.

● Dorico Pro users: You can find default settings for how music is notated, such as beam 
groups, how notes are split into ties, or voice columns, in Write > Notation Options (key 
command Ctrl/Cmd-Shift-N ).

● Options that are typically different in different layouts, such as page size or bar number 
positions, are in Setup > Layout Options (key command Ctrl/Cmd-Shift-L ), which is 
available in all product versions.

● We strongly recommend using the vertical spacing options in Layout Options to adjust the 
gaps between staves and systems. Dorico Pro users can move staves manually in Engrave 
mode, but staff spacing overrides can get deleted if the page they originally occurred on 
changes, such as if you add a title page at the start of the layout.

● Avoid entering project information directly on the page, especially if you have Dorico 
Elements or Dorico SE, because this creates a page override, as mentioned in Master pages 
and tokens. Add titles, composers, and other information in the Project Info dialog (key 
command Ctrl/Cmd-I ). If you have Dorico Pro, you can edit or create new master pages in 
Engrave mode to put that information where you want it.

● You can use time signatures to determine how notes are grouped into tie chains and beams 
by entering the beat grouping into the time signatures popover, such as 2+3+2/8. If you 
don’t want to show the beat grouping in the time signature, enter the beat group inside 
square brackets, such as [2+3+2]/8. This can be very useful in pieces with irregular meters 
but specific beat grouping: no need to change the beaming on each staff manually!

● If you want to input notes or rests with specific durations, you can use Force Duration 
(key command O ) to override Dorico’s default note and rest grouping.

● When the caret is active, you can press Shift-Up Arrow  and Shift-Down Arrow  to extend 
the caret to multiple staves and input notes and notations (using the corresponding 
popovers) on all those staves simultaneously.

● Dorico Pro users: If there are specific symbols you use frequently, create them as custom 
playing techniques or custom lines.

● For operations you perform frequently, check the Key Commands page in Preferences (key 
command Ctrl/Cmd-, ) as you can assign your own key commands for many options.

● For further questions and advice, the Dorico forum is an active and friendly place to go.
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A
a tempo 34
abbreviated instrument names 57
accelerando 34, 51
accents 30
acciaccaturas 41
accidentals 21, 22, 36, 38, 43, 51

spelling 47
adding. See inputting
alignment 67, 86, 90, 105
angles 68, 70
appoggiaturas 41
arpeggio signs 32
articulations 30
audio

exporting 85
output 73, 75

B
barlines 14, 15, 50
bars 14, 15

numbers 12
repeats 95

bass clef 36
beaming

cross-staff 45, 63
grouping 66, 105
inputting 16, 66
spacing 63

below the staff 48
black and white 83
booklets 82
buttons 4

C
caret 16

chords 18
grace notes 41
moving 16, 18, 22, 51
tuplets 38
voices 22

casting off 58, 61–63
cautionary accidentals 21
chords 18, 32, 36, 41

symbols 90, 92, 96
clefs 36, 51
codes. See tokens
collision avoidance 62, 70
color 83
composer 54, 55
con sordino 89
copies 82

copyright 59
cross-staff beaming 45
crotchets. See quarter notes

D
deleting

flow title 56
frames 59
instrument names 57
layouts 11
rests 37
staff labels 57
staves 103

demisemiquavers. See thirty-second notes
direction

slurs 68
stems 22, 65

dotted
lines 34
notes 16

double
barlines 15
flats 47

down-stems 22, 27, 43, 45, 65, 99
drum rolls 102
drum sets 97, 99, 102, 103
duplex printing 82
durations 16, 18, 38, 43, 51, 99

bar repeats 95
playback 34, 79
rhythm slashes 92
rhythmic grid 4, 73
tremolos 102

dynamics 28, 51
aligning 67
moving 51, 70, 79
volume 76

E
eighth notes 16
endings 50
Engrave mode 6, 55, 59, 68, 70
event display 4, 73
exporting 83, 85

F
fermatas 88
files 7

exporting 83, 85
printing 82

first ending 50
flags. See signposts
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flats 21, 22, 36, 38
flipping 48, 51, 65, 70
flows 7

numbers 55, 56
swing playback 102
titles 54–56, 73

font styles 55, 83
formatting pages 53, 58, 61–64
forte 28
frames 55, 58, 59
full scores 11, 103

order 97

G
gaps 70

beaming 63
dynamics 67, 70
note spacing 63
playback 79
staves 57, 62

grace notes 41
graphics files 83
grazioso 51
green line 73
groups

beaming 66, 105
dynamics 67
players 97

H
hairpins 28

aligning 67
moving 51, 70

half notes 16
hand indications 48
handles 34, 59, 68
headings 56
help 105
hiding

chord symbols 96
flow headings 56
panels 4
staff labels 57
staves 103

hooks 42, 50
hotkeys. See key commands

I
image files 83
indents 57
initial page number 64
inputting 12, 86

accidentals 21
arpeggio signs 32
articulations 30
bar repeats 95
bars 15
beams 16, 43
caret 16

inputting (continued)
chord symbols 90, 96
chords 18
clefs 36
dynamics 28
grace notes 41
key signatures 13
notes 16, 18, 22, 38, 41, 43, 99
octave lines 42
repeats 95
rests 16
slashes 92
slurs 25
tempo marks 34
ties 27
time signatures 14
tremolos 102
tuplets 38
voices 22

instruments 10
names 57
VST 74

interface 4
italics 48

K
key commands 8, 51, 105
key signatures 13, 15, 51
kick drum 99
kits 97, 99, 102, 103

L
landscape orientation 82
layers. See voices
layouts 7, 10, 11, 53, 55

exporting 83
hiding staves 103
names 103
printing 82
selector 4, 99

lead sheets 86, 88, 90, 92, 95–97, 99, 102
left hand 48, 64, 70
lengthening 28, 50, 51, 79, 105
lines

arpeggio signs 32
lyrics 86
octave lines 42
playback 73
repeat endings 50
tempo marks 34
velocity 76

loading sounds 74
lyrics 86

M
marcato 30
margins 58, 59
master pages 55, 59
measures. See bars
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mezzo piano 28
MIDI keyboard 16, 90
minims. See half notes
modes 6
mono 83
moving 51, 70, 105

caret 22
dynamics 67, 70, 79
slurs 68
staves 97
tempo marks 79

MP3 files 85
music area 4
muted 89

N
naturals 21, 36, 43
notes

accidentals 21
beaming 16, 63, 66, 105
caret 16, 18, 22, 38, 41
cross-staff 45
duration 16, 18, 38, 51, 79
grouping 63, 66, 105
inputting 16, 18, 22, 38, 41, 99
played duration 79
register 42
respelling 47
spacing 63
stems 65
tremolos 102
tuplets 38

numbers 14, 38, 50
flows 55, 56
pages 64

O
octave lines 42
offsets 63, 67, 68, 70, 86
orchestral order 97, 103
orientations 82

P
pages

formatting 53–59, 61–64
margins 58, 59
numbers 64
size 58

panels 4, 13, 14, 28, 32, 34, 36, 42
paragraph styles 55
parts 11, 103
pauses 79, 88
PDF files 83
percussion kits 97, 99, 102, 103
phrase marks. See slurs
piano

dynamics 28
instrument 10, 57

pitch 16, 18, 21, 51

Play mode 6, 73–75, 79
playback 73, 75, 76

muted sounds 89
note durations 79
repeats 50
swing 102
templates 74
tempo 75, 79

players 7, 10, 86, 97, 99, 102
chord symbols 96
groups 97
layouts 10, 11, 103

playhead 73, 75, 76
playing techniques 89, 99
poco 34
popovers 12

bars and barlines 15
chord symbols 90
clefs and octave lines 36, 42
dynamics 28
key signatures 13
lyrics 86
ornaments 32
playing techniques 89
repeats 92, 95, 102
tempo 34
time signatures 14
tuplets 38

portrait orientation 82
Print mode 6, 82, 83
printing 82

preview 4, 82, 83
watermarks 83

projects 4, 7, 9, 54, 55, 86
properties 4, 34, 37, 50, 70, 75, 79

Q
quarter notes 18
quavers. See eighth notes
quintuplets 38

R
rastral size 61
register 16, 18, 22, 41, 42, 51
repeat

barlines 50
bars 95
endings 50
tremolos 102

resetting
dynamics 76
layout options 53
playback templates 74

respelling notes 47
rests 16, 37, 43, 79, 88
rhythmic

dots 16
feels 102
grid 4, 16, 73
slashes 92

right hand 48, 70
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ritenuto 34, 51, 79
rolls 32, 102
ruler 73, 76, 79

S
saving

audio 85
PDF files 83

scores 11, 103
order 97

second ending 50
semiquavers. See sixteenth notes
Setup mode 6, 9–11, 97, 103
sharps 21
shortcuts. See key commands
shortening 28, 51, 79, 92, 105
sidebars. See panels. See also toolboxes
signposts 102
sixteenth notes 16, 38, 43
slashes 92

grace notes 41
tremolos 102

slurs 25, 68
snare drum 99
solo players 10
song lyrics 86
sounds 73–75, 79

muted 89
spacing 58, 59, 61–64
speed 34, 75, 79
spelling of accidentals 47
spreads 82
staccato 30
starting

chord input 18
grace note input 41
note input 16
projects 9
tuplet input 38

status bar 4, 73
staves 16, 18, 22, 48, 51

beaming 45, 63
chord symbols 96
fermatas 88
hiding 103
indents 57
labels 57
order 97
size 61
spacing 62, 63

stems 22, 45, 48, 65
audio 85
spacing 63

swing playback 102
switching

layouts 4
modes 6

system track 12

T
tabs 4, 99

templates
pages 55
playback 74

tempo marks 34
moving 51, 79
playback 75, 79
swing playback 102

tenuto 30
text 48, 59

font styles 55, 83
lyrics 86
moving 51, 70
title and composer 54–56
watermarks 83

thirty-second notes 16, 43
ties 27
time signatures 14, 66, 90
titles 54–56, 64, 73, 82
tokens 54, 55
tom-toms 99
toolbar 4
toolboxes 4
tracks 73, 76, 79
transposing 18, 42, 51
treble clef 36
tremolos 102
triplets and tuplets 38, 66, 102
two-up 64, 82

U
unpitched percussion 97, 99, 102, 103
unslashed grace notes 41
up-stems 22, 27, 43, 45, 65, 99
user interface 4

V
velocity 76
verses 86
vertical spacing 58, 59, 61, 62, 64
video 73, 75
voices 22, 36, 37, 45, 48

changing 51
percussion 97, 99
slashes 92

volta lines 50
volume 76
VST instruments 74

W
watermarks 83
WAV files 85
wiggly lines 32
wildcards. See tokens
windows 4
Write mode 6, 12, 13, 16, 86

Z
zoom 13

Index
 

109
Dorico 3.5.12


	Table of Contents
	Introduction
	Tour of the user interface
	Functions of the modes
	Dorico projects
	Key commands

	Setting up the project
	Starting a new project
	Adding a solo piano player
	Deleting the spare layout

	Writing music
	Popovers
	Adding a key signature
	Adding a time signature
	Adding bars
	Caret
	Inputting the melody on the top staff
	Inputting the chords on the bottom staff
	Adding accidentals
	Adding another voice to the top staff
	Adding slurs
	Inputting a tie
	Adding dynamics
	Adding articulations
	Adding arpeggio signs to chords
	Adding tempo marks
	Adding clef changes
	Deleting rests
	Inputting tuplets
	Adding a grace note
	Adding an octave line
	Inputting the music in bars 33-35
	Crossing notes to the other staff
	Respelling notes
	Adding indications for left/right hands
	Adding the repeat ending
	Finish writing the music

	Laying out and formatting pages
	Adding the title and composer
	Master pages and tokens
	Hiding the flow heading
	Hiding staff labels
	Changing the page size and margins
	Deleting the copyright text frame (Dorico Pro only)
	Changing the staff size
	Changing vertical spacing settings
	Changing note and cross-staff beam spacing
	Starting on a left-hand page
	Changing stem directions
	Changing beam grouping
	Aligning dynamics
	Adjusting the shapes of slurs (Dorico Pro only)
	Moving items graphically (Dorico Pro only)

	Playing back music
	Changing the audio output device
	Applying a playback template
	Playing back the piece
	Changing dynamic levels in playback
	Changing the poco rit. final tempo
	Changing the played duration of notes

	Printing and exporting
	Printing hard copies
	Exporting to PDF
	Exporting the audio

	Further notations
	Adding lyrics
	Adding fermatas
	Adding a mute playing technique
	Adding chord symbols
	Adding rhythm slashes
	Adding bar repeats
	Showing chord symbols above different staves
	Adding a drum set
	Inputting notes on a drum set
	Adding tremolos
	Enabling swing playback for the drum set
	Removing the drum set from the full score

	Final tips
	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	K
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W
	Z


